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1 
ABOUT THIS CLASS 

This class is intended as an introduction to the corridor modeler tools in GEOPAK. There are many 

techniques and options available within tools that can be used to solve unique situations that this class 

does not cover. 

OVERVIEW 

The Corridor Modeling tools are used for the construction of multi-layered three-dimensional roadway 

models. It is comprised of a subset of tools which incorporate coordinate geometry, graphical 

information, cross section templates and superelevation information to develop a model along a given 

corridor. The resulting model may be used to analyze, visualize, cut cross sections and extract data.  

The corridor is an entity which combines the terrain, alignment, profile and section details for the 

roadway under construction so that a 3-dimensional representation of the project can be created. A 

corridor is created by specifying the horizontal geometry, vertical geometry and the existing terrain. 

Details about the project are added by including templates which define the typical sections and 

applying superelevation. Variations occurring along the length of the corridor can be added using 

tabular or graphical methods.   

The tools support multiple corridors within a single project. It further supports creating multiple 

models along a single corridor, which allows for comparing design alternatives. In a complex project, 

individual corridors can be connected or targeted to achieve relationships between them. 

Developing the corridor is an iterative process. Details can be incorporated and results reviewed at any 

point in the process. The basic concepts and terminology are introduced and student exercises provide 

a chance to examine the process more closely. 
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CORRIDOR MODELING WORKFLOW 

The Corridor Modeling workflow is meant to be an integral part of the roadway design process. The 

preliminary proposed information can be used and viewed as a 3D Model or cross sections to inform 

subsequent design decisions. As the design changes, additional information may be included and the 

corridor is reprocessed to reflect these changes.  

 

FILE TYPES 

When beginning the modeling process, it is necessary to have a certain amount of existing and 

proposed design information established. Keep in mind that the process allows for incorporating 

updates should there be any changes. The following types of design information will be required 

throughout the process: 

 Existing surface information contained in a dgn file as terrain model element. 

 Proposed alignment and profile information contained in a dgn file. (With current workflow, this 

will be imported from the gpk.) 

 Proposed geometric information contained in a.dgn file. 

 Superelevation information contained in a dgn file. 

In addition, MnDOT CADD Standards and/or MnDOT Design Standards  information is also required. 

This type of information is not typically associated with a specific project. Rather, these files 

determine how the proposed cross sections are developed and what CADD symbology is associated 

with a given element. The following types of files are referred to within the modeling process: 

 MnDOT standard .dgnlib file 

 MnDOT standard template library, .itl 

The third types of files are those that are generated as a result of the corridor modeling process. These 

include: 

 GEOPAK database, .gpk file, for legacy tools and processes 

 3D Road Model and surface files, .dtm, .tin formats 

There is a listing of the project workflow and the files required by and generated from each step in the 

Appendix. 
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PROJECT SETUP 

The tasks within the Corridor Modeling workflow allow for the selection of MicroStation elements for 

control or to snap to for relative position. It is suggested that only the necessary files needed for the 

corridor be attached to simplify the file reference structure. 

REQUIRED FILES 

For the Corridor Modeling steps of the workflow, an alignment with vertical profile and a template is 

all that is required to model. The model will solve as much of the template as possible. If a terrain is 

added additional components may solve.  

Warning: The user must be careful to keep all attached references available. In the 
initial versions of SS3, the software crashes if a reference is lost and there is 
no way to reconstruct. Currently, keep everything except the terrain model in 
a single file if possible for each corridor. 

project_al.dgn This file contains the alignments plotted from the D&C manager. There at this time 

there are no “civilized” elements in the file. Future software will enhancements will allow this file to 

replace the GPK. For now making sure the GPK and any Civil element are in sync is a manual process.  

project_cm.dgn This files starts with a 2D seed and then the software creates a 3D model contains the 

corridor objects. This is the file where the corridor resides. It contains the alignments, profiles, plan 

graphics and superelevation. The project terrain file is attached, as well as necessary design files used 

in the construction of the model. 

project.itl Each project will have its own template library which is a special file type designated 

by the .itl extension. 

project_dtm.dgn  Existing ground data will be stored as a MicroStation Terrain Element 

within its own design file. The source may have been an existing .tin file or survey data. The terrain is 

not required as the model will solve as much as possible without it. 

project.gpk  The master alignment and profile information is stored here. The GPK is not 

required in order to generate the 3D Corridor Model, but, the gpk file is required for most of the legacy 

GEOPKAK operation. The gpk must be in sync with the design files. Otherwise problems can occur 

with alignment labeling, station-offset labeling or and earthwork calculations are run. 

VERIFY FILE SETTINGS AND USER PREFERENCES 

Currently there is not one single location for setting preferences in the project.  It relies upon a 

combination of MicroStation Design File Settings, Civil Settings, GEOPAK User Preferences, XIN 

preferences and Report preferences to determine units, output accuracy.  

Part of the file creation process is to set these various design file and user preference settings. These 

settings should be verified when starting work in unfamiliar files. 

1. Annotation Scale 

2. GEOPAK Classic User Preferences 

3. Design File Settings for Civil Formatting 

4. XML Report Settings 

5. Geographic Coordinate System 
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REVIEW DESIGN FILE SETTINGS FOR CIVIL FORMATTING AND ANGLE READOUT 

Design file settings specific to the Civil Tools have been set up within the MnDOT seed files. These 

settings, which may be reviewed within the Design File Settings dialog, control the formatting of 

coordinates, stations, radii, and profile.  

The Export Settings > Export to Native option controls whether Civil Geometry Elements created 

with the Civil Tools will automatically link to the legacy COGO database. If this option is set to Use 

Feature Setting, the export will be controlled by the Feature Definition for the individual Civil 

Geometry Element. The option to automatically link to COGO (autopersist) is disabled for all MnDOT 

Feature Definitions. This should not be changed. 

To support the legacy GPK database, the Station Settings > Equation option must be set to By Index 

to get GEOPAK regions.  

If any changes are made to Design File Settings, it is important to save the settings for future sessions 

(File > Save Settings). If any changes to the unit precision are made a redraw of the elements must be 

done to update the graphics.  

 

 

Note: The current seed files do not have the angle readout set yet to North or 
Clockwise... 

INSTRUCTOR DEMONSTRATION 

The following is a high level overview of the Corridor Modeling process. 

1. Corridors are created. This example uses the SOUTHST alignment in d340814_Demo.dgn.  

 

2. In order for a corridor to target ground there must be an active terrain model.  The active 

terrain model may be verified using the terrain model context menu or by navigating to the 

Referenced Models in Project Explorer. 
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3. The Corridor Modeling task menu holds the tools needed for creating and working with a 

corridor. The first icon in the menu is the Create Corridor icon. If there is a horizontal 

alignment with an associated profile a corridor may be created. Select the Create Corridor 

icon to open the Create Corridor dialog and initiate the floating prompts. 

 

4. The Create Corridor dialog shows that a profile, an alignment and a design stage need to be 

chosen. The first floating prompt allows the graphical selection of the Corridor Baseline 

alignment. Moving the cursor to the alignment highlights it as the temporary selection. 
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5. Left Clicking accepts the selection and brings up a prompt for profile selection. The majority 

of the time the active profile will be used for the corridor. 

 

 

6. Next there is a prompt for the Corridor Name. The default name in the prompt can be 

overwritten, but usually not necessary as it follows the alignment name. 

 

7. When the Corridor Name entry is accepted, the Corridor becomes outlined in red, the Create 

Template Drop dialog opens, and a floating prompt appears to select the template to be 

inserted into the corridor. Floating prompts will step through each entry shown in the dialog 

box. Each default entry from the dialog box must be accepted, or changed and then accepted, 

via the floating prompts. 
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8. The corridor processes immediately, with information available in various viewing formats. 

 

 

9. Refinements can be made using the corridor context menu, the template drop context menu, 

the Corridor Objects interface, or via Project Explorer entries. 
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Corridor Context Menu 

 

Template Drop Context Menu 

 

Corridor Objects 
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Project Explorer 

This ends the demonstration of the basic corridor creation workflow. 

IMPORT PROJECT DATA 

Current workflows require the import of specified GEOPAK based design information. This is due to 

software limitations and functional areas in different stages of implementation of new workflows. 

Legacy tools, like earthwork and plan production, still require the use of and the GPK. 

For known issues and bugs please see MnDOT reports at: 

pw:\\PW8i.ad.dot.state.mn.us:cadp\Documents\OTS\CAES\Bugs\Bentley\V8i_SS3\ 

V8i_SS3-013.bug, V8i_SS3-025.bug, V8i_SS3-026.bug - Bugs with alignments and referencing 

issues. 

Additionally, it may be advantageous to disable snap and locate for extraneous references. 

TERRAIN MODEL 

A terrain model is a MicroStation element class that contains surface information similar to a TIN file 

in GEOPAK. The terrain is stored in a 3D dgn file. It can be created, modified, analyzed and displayed 

with the various tools in MicroStation and GEOPAK. Instead of selecting a TIN file in dialogs, the 

new tools use referencing and selecting which terrain is active. 

The Feature Definition in combination with the associated Element Template control the visualization 

of the terrain. By default only the boundary and voids are displayed for the terrain at MnDOT. The 

matching element template (Element > Element Templates) can be modified to display more or less 

features of the terrain. These settings can also be overridden when the terrain in referenced. 

Currently, unless there is a Terrain Model dgn file created by surveys, the design group will have to 

import the data to create the terrain.  

For this class the terrain has already been imported to the d340814_dtm.dgn file. For further 

information on Terrain models, see the terrain training material. 

pw://PW8i.ad.dot.state.mn.us:cadp/Documents/OTS/CAES/Bugs/Bentley/V8i_SS3/
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 Import Existing Ground Surface Information (Reference Only) 

1. Copy the 3D seed file E3Dseed.dgn from 

\Documents\CADDStandards\MnDOTStandards\DOT_MICRO\seed\ 

2. Rename to d340814_dtm.dgn and open the file. 

3. On theTask menu, select Civil Tools > Terrain Model > Create From File. 

 

4. Select d340814_exist.tin, click OK. 

5. Set the Feature Definitions option to Terrain > GRND-INP, Click Import. 

 

6. Close the dialog, fit the view, save settings and exit. 

IMPORT ALIGNMENT GEOMETRY 

At MnDOT, current workflows require the import of alignment and profile geometry from a GPK file. 

Currently the geometry should reside in the same file as the corridor. This is due to instability within 

the corridor if an alignment is missing or deleted. 

When an alignment and a profile is imported into a 2D file, a corresponding model is created (3D – 

Default) that contains a corresponding 3D line string of the data. At this time, the alignment is not 

annotated with stationing, equation and curve data. If necessary reference the data from the alignment 

file used for plans production. 

If importing multiple profiles associated with an alignment, verify that the appropriate profile is set as 

active using the element information tool or Project Explorer which is shown later in the class.  

 Import Alignment and Profile Information 

1. Open file d340814_cm.dgn. 

2. Verify that d340814_dtm.dgn is attached as a reference. 
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3. On the Civil Tools > General Geometry task tab, click Import Geometry. 

 

4. In ProjectWise, select the job814.gpk from your student folder, click Open. 

5. Expand the Alignment category, expand and select the SOUTHST alignment, SOUTHST 

profile and DITSSR profile. If you select the profile the alignment is automatically selected. 

 

Note: When modeling after the fact, select all profiles that are related to the alignment 
for import so they are available. 

6. Leave the Create Civil Rules toggled ON. 

7. Click Import. 

8. Fit the view. 

9. Select the element. Set the Feature Definition to Linear > Alignment > ALIN. 

10. Select the element information tool and select the alignment.  

11. Expand the Complex Element; Verify that SOUTHST is the active profile. If not Right-Click 

and Set as Active profile. 
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12. Review other information in the dialog. 

13. Save and exit the file. 

SUMMARY 

For each corridor within the project, the modeling workflow is an iterative process that dynamically 

responds to information as it is imported or defined. This course focuses on assisting the user in 

gaining a basic understanding of this workflow, utilizing the MnDOT standards and creating models to 

achieve accurate results. 
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2 

OVERVIEW 

Individual templates are stored in template libraries (.itl file name extension). These are separate files 

which can be accessed by multiple users. In the MnDOT workflow, each project will have its own 

template library. Individual templates which meet the basic design needs will be copied from the 

MnDOT standard template to the project template library and modified as needed.  Requests for new 

template variations to be added to the standard template library can be submitted to the CAES Unit for 

consideration. 

This chapter is intended to provide basic information for reviewing and basic creation using the 

provided components in from the MnDOT library. 

REVIEW THE TEMPLATE LIBRARY 

The Create Template dialog displays a tree view of the contents of the template library. Navigating 

through this folder structure allows the user to preview or activate each of the various components or 

templates.  

A graphical interface dominating the Create Template window displays information and graphics 

associated with the Current Template. To make a template the Current Template and active for 

reviewing and editing, double left click on the template name in the tree view. A template is shown in 

the Preview view at the bottom left when the template name is highlighted with a single left click. 

 

TEMPLATES 

Templates are fundamental building blocks of a corridor model. They are made up of individual 

elements and groups of elements, referred to as components, which represent individual aspects of the 

design. Components are constructed of a series of points which are stored relative to one another. 
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Note:   In the context of templates, the term “point” is used to describe the vertices of 
components or templates. Such points have no relation to points stored in a 
coordinate geometry database. Template points are positioned at each template 
drop and connect to form line strings. 

 

Rural – 2 Lane Template 

The MnDOT standard template library contains basic templates that represent standard rural and urban 

designs, including the components and point definitions used to construct them. For each project the 

MnDOT seed template library is copied and renamed for project purposes. After creation, templates 

are copied from the standard library and customized to incorporate project-specific situations. 

Depending upon the data available, project templates dynamically respond to location-specific 

information, such as: 

 Horizontal and vertical alignment information. 

 Graphical elements that define the presence and dimension of roadway elements. 

 User-defined values that define the presence, dimension, and/or slope of roadway elements. 

 Pavement cross slopes, as determined by superelevation information. 

 Existing or proposed surface information that determines connection points 
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MNDOT TEMPLATE LIBRARY 

MnDOT maintains a master template library with pre-existing templates that represent common road 

design configurations. In addition, the MnDOT template library contains “building block” templates – 

templates representing single roadway elements such as pavement, shoulder or curb - which can be 

assembled to create templates representing new configurations. The majority of these components are 

side specific because of the point naming convention that is embedded in them. Typically users will 

assemble ‘Left’ and ‘Right’ sides to make the roadway core. Then they will add appropriate end 

conditions for their specific job. Once created minor modification will be made to fit site conditions. 

Each component is built using default dimensions that control the horizontal distance, the vertical 

distance, and/or the slope between points along the component. These settings are referred to as point 

constraints. Any point may have up to two constraints. Within the template viewer, points with two 

constraints will be displayed as red; points with one constraint will be displayed as yellow; and 

unconstrained points will be displayed as green. The default values that are used to define constraints 

may be overridden with project-specific values, as will be discussed in a subsequent section. 

The MnDOT template library is located at: 

...CADDStandards\MnDOTStandards\DOT_GEOPAK\modeling\MnDOT_Template.itl 

DIRECTORY STRUCTURE 

The MnDOT standard template library for corridor modeling is split out into distinct sections.  

 

Components – This folder contains the “building blocks” of a roadway template and the individual 

parts that comprise templates in the other directories. 

End Conditions – This folder contains unique components that target surfaces or other template 

components. Typically they are used on the outside of the roadway to tie to existing ground.  

Grading Templates – The grading templates folder contains complete templates that are comprised of 

components and end conditions that are typically used for full grading and reconstruction projects. 

Inplace Templates – This directory contains templates that can be used for modeling of inplace 

materials, such as existing topsoil and existing pavement. 

OverlayWidenMillTemplates – This directory contains templates used in rehabilitation, preservation, 

rehabilitation and widening projects.  

SiteTemplates – This directory contains templates for site objects like ponds.  

TEMPLATE NAMES 

The template names attempt to describe the contents of a template. An “x” is used as a place holder to 

designate optional fields. 

 Example: C&G Design Bxxx – Modification of Parametric constraints in the template allow 

the it to be B612, B624, B424, ect… 
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CREATING TEMPLATES – GENERAL RULES 

Create components and end conditions for 1 side of the roadway (Typically a right side) without 

affixes applied. Maintain it without the affixes in the “Parts” directory. 

Parts directories under a parent folder contain templates without affixes applied. 

When affixes are applied or components are merged be sure to clean up the names tobe consistent and 

accurate for the new condition.  

Build templates from left to right.  

For ease of template modification, avoid setting the same parametric constraint to multiple points in a 

template. 

Components, Parametric Constraints, Points and Display Rules should be in all caps and no spaces in 

the names. (Excludes descriptions and template names.) 

Use standard abbreviations/acronyms in items, points, component names and parametric constraints to 

shorten names. Attempt to make them all 4 characters. SUIT = Suitable, SHLD = Shoulder, AGGR = 

Aggregate 

 

 

Use an underbar (“_”) between the side prefix and the component name and an underbar (“_”) between 

the component name and the position. 

For complex components and end conditions where multiple points are necessary additional criteria 

may be added following the component name in the point naming. A dash (“-“) is added following the 

component name. The descriptive criteria should designate a specific location, function or feature of a 

template.  

 

MNDOT - CM POINT NAMING CONVENSION – General 

SIDE 
PREFIX 

COMPONENT 
NAME 

OPTIONAL CRITERIA       
(-XXX) 

POSITION 
(VERT:HORIZ) POINT NAME = DESCRIPTION = 

L_ SHLD 
 

_TI L_SHLD_TI Left Shoulder Top Inside 

R_ MEDN 
 

_TO R_MEDN_TO Right Side Median Top Outside 

R_ DTCH -BTM _TI R_DTCH-BTM_TI Right Ditch Bottom Top Inside 

R_ DTCH -BKS _T R_DTCH-BKSL_T Right Ditch Backslope Top 
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The naming of components, point and constraints should be contiguous in nature, so that it is readily 

apparent what ones go together. See the following example. 

 The BERM component points and parametric constraints contain BERM in the name so it is 

readily identifiable. 

 

COMPONENTS/ END CONDITIONS 

Correct the parent/child relationships for the open and closed components. The closed components 

should be a parent component of the open unless it is an end condition. When multiple closed 

components exist in a complex template set the parent/child relationships. 

Closed Components: The closed component is the parent component.  

End Conditions: The open component is a parent of the closed component.  

The open/ top surface component should have the exact name of its parent closed component, with the 

suffix “TOP.” This should simplify the editing by making it a rule to only change the closed 

component. Additionally it would be easier to remove/delete the open component without re-working 

the templates in the future. 

Separate out the individual components of more complex templates to their individual parts. Verify the 

point names are consistent once separated and they can be easily added back together to recreate the 

complex solution. 

Labeling the lane components: For the first lane use LANE, if a pavement section is wider that one 

lane the following lane will be LANE1. The same methodology applies for turn lanes TURN.  

End conditions component names should describe what they are doing. FILL, CUT, DTCH, and the 

names of the corresponding points should match. 
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POINTS 

Points symbology style should use the same name as the component, unless used for testing points or 

drawn in the plan as a style constraint. If the point is used in testing then the symbology should be 

“DNC-xxxxxx.”  

Points that are needed for plan graphics or target a plan graphic style should match the corresponding 

DDB item. 

The centerline alignment points of a template should be labeled as CL first. This varies from the 

normal MnDOT point naming convention. 

SEARCH, TEST, REF (Reference) or NULL points should all be labeled as such in the optional 

criteria field of the point naming convention.  

Separate multiple testing points so that they are readable if possible unless intended to be merged 

togther. Horizontal testing points should be above the finished grade. 

 Format: (SIDE)_(COMPONENT)-(SEARCH)_(POSITION) 

 Example: R_FILLCZ-SEARCH_T 

 SEARCH – used for a point that searches for a plan view graphic 

 TEST – used for a point that test for a condition within a template 

 REF – used as a point of reference for a Test or search point 

PARAMETRIC CONSTRAINTS 

If mirroring components to construct a template, update the parametric constraint names to include the 

prefix for the side. 

Construct and match the name of common parametric constraints so that they automatically combine. 

Example: TOPSOIL_THK 

 ALTERNATE SURFACES 

Default alternate surfaces are setup in the templates for the Grading Grade (GGRD) and the Subgrade 

(SGRD). 

 



Project Template Library 

 

Copyright © 2015 Minnesota Dept. of Transportation  Project Template Library 

4/16/2015  2-7 

PROJECT TEMPLATE LIBRARY 

Project template libraries will be created by copying templates from the MnDOT_Template.itl. One 

Project Template Library will be created and maintained for each user so that the designer can have 

template editing capabilities and to preserve the template configurations used in the project. The goal is 

to minimize the libraries used in a particular project. If only one user is modeling the project then only 

one library is necessary. 

The template library is accessed using the Create Template icon in the Corridor Modeling task 

menu. 

 

The Project_Seed_MnDOT.itl template library does not contain any templates, just the file folder 

structure that matches the MnDOT standard template library, with an additional folder for project 

specific templates. 

 

The Template Library Organizer, found in the Create Template > Tools menu, is used to copy 

templates from the standard MnDOT template library into the project template library. Users will copy 

the subset of standard templates which apply to the project.  

For example, on a project with a basic rural corridor, the Grading Template > Rural – 2 Lane > 

GradeSub  template would be copied from the Grading Templates folder into the folder of the same 

name in the project template library. 

Note: The template library reverts to the standard MnDOT library every time a file is 
closed. The project template library will have to be re-opened every time a new 
session of MicroStation is opened. 

 Create and PopulateProject Template Library file 

1. In ProjectWise, navigate to the MnDOT seed template library: 

...CADDStandards\MnDOTStandards\DOT_GEOPAK\modeling\Project_Seed_MnDOT.itl 

2. Copy this file to your ProjectWise student directory and rename it d340814_cm.itl. 

3. Open the d340814_cm.dgn design file containing the SOUTHST alignment. 

4. Open the template library via the Create Template icon. 
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5. Hover over the top line in the Template Library viewing window to see the pathname of the 

current template library. 

6. Click on the various folders and template names to become familiar with the 

MnDOT_Standard_Template.itl. The Preview window below the list window shows a 

preview of the highlighted template. 

7. File > Open, select the d340814_cm.itl. 

8. Select Tools > Template Library Organizer. 

 

9. Select the browse icon  near the upper right corner and browse to the 

MnDOT_Template.itl in the CADD standards folder. 

10. The MnDOT Standard template library folder appears in the right pane. 

 

11. Highlight the Rural – 2 Lane - GradeSub template in the Grading Templates folder on the 

right panel and drag it to the Grading Templates folder on the left panel to copy from the 

MnDOT_Template.itl to the project template library, project.itl. 



Point Properties 

 

Copyright © 2015 Minnesota Dept. of Transportation  Point Properties 

4/16/2015  2-9 

Note: Put copies of the original MnDOT templates into the same folder they came 
from. Use the ProjectTemplates folder later for editing the templates with project 
specific information. This way you have a reference to go back to. 

12. Expand the Components folder in the MnDOT Template Library Listing. 

13. Highlight and Drag the _Left and _Right folder from the MnDOT_Template.itl into the 

Components folder in the project template library. 

14. Expand the EndConditions folder in the MnDOT Template Library Listing. 

15. Drag _Left and _Right folder into the project template library EndConditions folder. 

16. Select OK. 

17.  Select Yes to Save data to the project.itl. 

18. The Template Library Organizer closes; the Create Template window remains active. 

19. Leave the Create Template window open for the next lab. 

POINT PROPERTIES 

Template Constraints, Parametric Constraints, and Style Constraints are all referenced within the Point 

Properties, as defined within the MnDOT standard template library. Point Constraints are applied in 

the order listed within the Point Properties dialog, with the most recent constraint found taking 

precedence. 

Point Properties for a particular template point illustrate a number of things: 

 

 A template that is ready to be dropped into a corridor will have points with L_ and R_ prefixes to 

distinguish left from right. It should not have duplicates, ie: L_L_BERM_TO 

 Point names follow a naming convention which help identify the purpose of the point – in this 

example, this point is the Left BERM Top Outside corner point. 
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 This point has a Feature Definition of BERM which defines the properties of the graphics to be 

created by this point in the 3D model. 

 The Superelevation Flag check determines which points can be selected when applying 

superelevation to the corridor. 

 This point has 2 constraints, a Horizontal Constraint, and a Slope Constraint. These are the 

Template Constraints, and they set the initial default location of the point. 

 Both of the constraints on this point can be controlled using parametric constraints because they 

both have a parametric Label entry. 

 The horizontal location of this point can be controlled using graphics because it has the 

Horizontal Feature Constraint checked and a feature definition, BERM, is entered. 

TEMPLATE CONSTRAINTS 

Constraints control the position of design elements in a template. There are many different types of 

constraints. Each type can be used to make the design flexible to changing conditions. 

Multiple methods are available to assign location-specific information which determines the position 

of template points. It is possible to have multiple constraints directing a point at a single station 

location. A solid understanding of how these constraints are used and which constraints take 

precedence will allow the designer a great amount of flexibility in addressing complex design 

situations. 

When placed within a component or template, each point may be limited by up to two constraints 

which are referred to as the Template Constraints. The constraint Values used in MnDOT standard 

templates are defined by MnDOT and represent common values for such dimensions as depth, width, 

and slope. In the MnDOT workflow, template constraint values may be changed to match project 

typical section values. 

Default template constraints are overridden by all other constraints or point controls, when present. 

This is generally the order of processing the location of points and components at each template drop 

(lowest to highest priority). 

1. Points are placed according to the point constraints stored in the template. 

2. Parametric constraints are applied as defined in the template, and in the object browser. 

3. Style constraints are solved from the current position of the point. 

4. Point controls are applied to the assigned points, overriding the corresponding constraint. 

5. Component display rules are solved based on the current position of all points. 

6. End conditions are solved by extending designated segments along the specified slope to seek 

their targets 

If there are multiple point controls, the priority will control which gets used. 

PARAMETRIC CONSTRAINTS: 

Point constraints that commonly vary from the typical section value have (Parametric Constraint) 

Labels defined within their Point Properties. These (Parametric Constraint) Labels are then available 

for selection to assign alternate values to the labeled constraint. The MnDOT standard template library 

uses common label names across templates and the label names are descriptive of the component they 

control. Parametric constraints correlate to redefinable variables in the classic GEOPAK criteria 

workflow. 

In the MnDOT workflow, templates should be set to the typical section values and Parametric 

Constraints used to override where the value deviates. When used in a corridor they may be limited to 

apply only within defined station ranges. 
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HORIZONTAL FEATURE CONSTRAINTS: 

Horizontal Feature Constraints allow modification in the corridor based on graphics. Three things 

must be in place in order to use graphics to control the point location: 

 Template: In the Point Properties, the Horizontal Feature Constraint must be toggled on 

with a feature name and search range specified. 

 Geometry with the specified feature must exist in the working design file within the specified 

search range and is direction specific. 

 The graphic element(s) must be made known to the corridor by being added as corridor 

reference.  

When these conditions are met, Horizontal Feature Constraints override both Template 

Constraints and Parametric Constraints. Horizontal Feature Constraints may be limited to apply 

only within defined station ranges and correlate to INDGN graphics in the classic GEOPAK criteria 

workflow. 

POINT CONTROLS 

Point Controls are specified directly in the corridor and not within the template Point Properties. When 

present, Point Controls overrule default Template Constraints, Parametric Constraints, and Horizontal 

Feature Constraints. Point Controls may use value-based definitions, alignment information, or feature 

definitions to determine the location of a template point. Superelevation information is also treated as a 

Point Control to control the cross slope between two template points. 

Point Controls may be limited to apply only within defined station ranges. 

 Review Standard Components (optional) 

1. Within the tree view on the left side, navigate to Components > _Left. 

2. Highlight L - C&G Design Bxxx with a single click on the name. 

Notice the graphic that appears in the preview window. 

3. Double click on C&G Design Bxxx to make this component active as the Current Template. 

Notice the information and graphics within the graphical interface. 

4. In the Display settings area of the interface, toggle on Display Point Names. 

How many points appear in the graphic interface? ____________________ 

Which of these points are unconstrained? ___________________________ 

What indicates that a point is unconstrained? ________________________ 

5. With your cursor, hover over the element between points L_CURBB_TI and L_CURBB-

FACE_TO. An information box appears. 

What is the material type for this element? __________________________ 

What is the default value for the width of this element? ________________ 

6. Double click on the point L_CURBB-FACE_TI. 

7. In the Point Properties dialog, what is the name of the Parent Point which constrains the 

horizontal position of L_CURBB-FACE_TI? __________________________ 

8. Close the Point Properties dialog. 

9. Review other elements under the Components subfolder. 



End Conditions 

 

End Conditions  Copyright © 2015 Minnesota Dept. of Transportation 

2-12  4/16/2015 

END CONDITIONS 

An End Condition is a special type of component which connects proposed design elements to a 

surface, graphics, features or elevations. Multiple end conditions may be used together to create a 

decision tree so that components draw differently depending on which end condition is successfully 

solved.  For example, end conditions are used to “choose” whether to connect to existing ground with a 

cut component, a fill component or a ditch component. 

In the Create Template graphic interface, all of the end condition alternatives are drawn 

simultaneously. The Test End Conditions tool may be used to interactively display how the 

component will behave under various cut or fill situations. This tool is accessed by clicking the Test 

button. Within the resulting dialog, the active end condition is pictured. Clicking the Draw button, and 

then dynamically dragging the mouse up and down within the graphic view, allows the user to observe 

the behavior of the end condition for various existing ground elevations. 

Templates are built with a series of components, including end conditions, to represent a typical cross 

section of a roadway. Templates representing standard urban and rural design situations are included in 

the MnDOT template library. Like the individual end condition components, these complete templates 

may also be reviewed with the Test End Conditions tool. 

Multiple end conditions can be applied to a template. When multiple end conditions originate from a 

common point a priority must be assigned to determine the order of solution. In the MnDOT template 

library default priority values have been assigned as a starting point. 

 

 Test End Conditions 

1. Within the active template library, navigate to and select EndConditions > _Right > R – 

Ditch/Fill. 

2. Click the Test button on the bottom right side. 

3. In the Test End Conditions dialog, highlight <Active>-Surface in the Available Targets list 

box. 

4. In the Use Surface Slope: field, enter a value of 4.00%. 

5. In the Test End Conditions dialog, click the Draw button. 

6. In the Test End Conditions graphic interface, drag the cursor up and down to observe the 

results. Be sure to move the cursor below the bottom of the ghosted ditch lines. 
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Note:  End conditions with multiple targets, such as clear zone, can be tested in the 
same window by clicking on the other items which are listed as Available 
Targets. 

7. When finished, click the Close button. 

Notice the Create Template dialog is disabled when the Test End Conditions tool is 

active and reappears upon closing the tool. 

8. Remain in the Create Template dialog and active MicroStation file for the next exercise. 

 Review Templates 

1. Double click on the Grading Templates folder to open it. 

2. Double click on the Rural – 2 Lane template 

3. In the Display settings area of the interface, toggle on/off  Display Point Names. 

Note: A series of view tools are available at the bottom of the template graphical 
interface. These may be used to zoom in on a specific area of the template. 
Additionally the mouse buttons can be used to navigate the window. 

4. With your cursor, hover over the element between points L_SHLD_TO and L_TURN_TO. An 

information box appears. 

1. What is the Component Name for this element? _____________________________ 

2. What is the default value for the slope of this element? ___________________ 

5. How many points within the template are partially constrained? ________________ 

6. Click the Test button to open the Test End Conditions dialog. 

7. Highlight <Active>-Surface in the Available Targets: list box. 

8. In the Use Surface Slope: field, enter a value of 4.00%. 

9. In the Test End Conditions dialog, click the Draw button. 

10. In the Test End Conditions graphic interface, drag the cursor up and down to observe the 

results. Click in the graphic interface to draw an active surface line. 

11. When finished, click the Close button. 
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SET CORRIDOR SPECIFIC TEMPLATE VALUES 

The templates in the MnDOT template library are set up with dimensions commonly used in roadway 

construction. These will need to be edited to reflect project specific values.  To simplify template 

management, templates used in the project are collected a subfolder to organize templates by 

alignment or corridor. 

A copy of the original templates is made into the project library, from those copies a project specific 

template is made. 

Typical sections are reviewed first in order to select the most applicable template(s) from the MnDOT 

Template library. These templates are copied into the ProjectTemplates folder. Then template 

dimensions are compared to typical section dimensions and individual templates are edited to make the 

template values match the typical section values.  

For example, the Rural - 2 Lane - GradeSub template includes thru lanes and turn lanes.  The thru lane 

default widths are 12 feet and can be controlled with the parametric variables L_LANE_W and 

R_LANE_W. The default pavement depth is -1.0 foot with the parametric variable called LANE_THK. 

The thickness value is negative because it is measured down. 

Other template variables include turn lane and shoulder widths and slopes, grading depth, subcut 

depth, and inslopes.  

 

The original template values are compared to the typical section values, and the parametric label names 

are used to find and edit the template values. 
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 Create corridor specific template folder 

1. Within the Template Viewing Tree, right click on the root folder. 

2. Select New > Folder. 

3. The default folder name, New Category, is highlighted for editing. Type  SOUTHST to 

rename this folder. 

4. Hit the <Enter> key on the keyboard. 

5. Remain here for next exercise 
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 Review typical sections and copy applicable template to project template folder 

1. Refer to the SOUTHST typical section. 

Is this an urban or rural section?_________________________________ 

2. In the project template library, double left click on the GradingTemplates folder to open it. 

3. Single left click on the Rural - 2 Lane – GradeSub template to highlight it. 

Note: This template was copied into the Grading Templates folder of the project 
template library using the Template Library Organizer tool in a previous 
exercise. 

4. Right click and select Copy. 

5. Right click on SOUTHST folder. 

6. Select Paste to place a copy of the template into the corridor folder. 

7. Double click on the SOUTHST folder to open it. 

8. Right click on the Rural - 2 Lane – GradeSub template and select  Rename. 

9. Give the template a new name of SOUTHST. 

 Set corridor Specific Template Values 

1. Double left click on the SOUTHST template to open it as the Current Template. 

Note: Before editing a template, always confirm that the correct template is active by 
checking the Current Template Name 

2. Select the Active Template tab (below the left viewing pane). 

This brings details specific to the current template into the left viewing pane. 
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3. Left click on the + next to the Parametric Constraints folder to expand it. 

4. Click once on L_LANE_W. 

Notice that the points affected by this Parametric Constraint are highlighted with blue boxes 

in the template viewing pane. 

5. Which points are affected by LANE_THK? ________________________________ 

6. Double click on L_LANE_W to open the Edit Default Parametric Value dialog. 

What is the default value of L_LANE_W? ________________ 

From the South St. typical section, what is the width of the left thru lane? ____________ 

 

7. In the Edit Default Parametric Value dialog change the Default Value to -16.0. 

8. Click OK to save and close. 

9. Hover over the top line of the component between points CL_T and L_LANE_TO. Verify 

that the lane width has changed. 

10. The typical section shows no turn lane on either side. Double click on the Parametric 

Constraints L_TURN_W and R_TURN_W and change their template values to zero. 

Hint:      This places two points on top of each other. When more than one point has 
the same x-y coordinates, the user can double click at the point location and 
select the desired point by point name from a pop-up list. 

Note: While it is possible to zero out components in a template, it is a best practice to 
create the template without the components in the first place. 

11. Review the typical section on the following page and change other Parametric Constraints 

as needed. 

Hint:      Check the ditch variables 

12. Choose File > Save to save your project template edits.  

13. Close out of the template library. 

14. Close and check in files. 
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SOUTH STREET TYPICAL - ALSO IN  D340814_TS.DGN 
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3 

INTRODUCTION 

Now that there is a preliminary understanding of both the workflow and templates, students will create 

a simple corridor and then examine the corridor more closely with several exercises which make 

revisions to the corridor. 

Data within design files can be divided into multiple models within that design file. In the project_cm# 

design files, the graphics and horizontal alignment are stored in the Default model. The 3D model is 

stored in a separate model, called Default-3D within the same design file. 

To help ensure selection of appropriate elements, turn off the display, snap and locate for reference 

files. 

CONTEXT SENSITIVE TOOLS 

Context Sensitive Tool bars are available to choose tools. This means that depending on what is 

selected the available tools will update for actions for that particular element.  AccuSnap settings 

control this feature (Settings > Snaps > AccuSnap) With either Pop-up Info disabled or set to 

Tentative and/or Identify Elements Automatically disabled the Context Sensitive tools are unavailable. 
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FLOATING DATA ENTRY PROMPTS 

In the last exercise to open the profile model view, floating prompts were visible near the cursor telling 

the next action required. In that case the prompt was to select or open which view should be used for 

viewing the profile model. 

In many of the tasks related to creating and refining a corridor, there is a long list of entries to be made 

in order to complete the command. Usually there is a companion dialog box where the user can make 

the required entries which usually (but not always) appear as the default entries in the floating prompts. 

Whether the user makes any entries in the dialog box or not, the floating prompt will cycle through the 

required information.  Each floating prompt will be pre-filled with an entry that must be accepted by a 

left mouse click. If the information showing in the floating prompt is not correct, it must be corrected 

prior to accepting. When an entry is accepted, the next prompt appears. 

Note: Generally the floating prompt will not appear until the cursor is moved into the 
view window and off of any dialog boxes. 

ACTIVE TERRAIN 

In order for end conditions to solve to ground they need an active surface to target. This is 

accomplished by setting an active terrain in the dgn file. 

 Set Active Terrain 

1. Open d3401814_cm.dgn. 

2. Reference d340814_cp.dgn. Turn off snap and locate for this reference. 

3. Highlight the boundary element of the terrain and select Set as Active Terrain Model from the 

context sensitive toolbar.  
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VIEW SETUP 

When a new view window is opened, it opens into the same model as the currently active view 

window. In the MicroStation View Attributes dialog the model can be changed to a different model 

that resides in the file. 

 

 Set up views for reviewing the corridor 

1. Open views 1, 2, 3 and 4 using the view toggles. 

2. Tile the view windows (Window > Tile). 

3. Fit View in View 1 – Default View 

4. Zoom in to the area around the SOUTHST alignment. 
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 Set Up View 2 for the 3D model 

1. Open the View Attributes for View 2. 

2. In View Setup > Models, select Default-3D using the drop down menu. 

 

3. Fit View. 

4. Zoom in on the SOUTHST alignment area. 

5. Select View Rotation: Isometric View. 

 Set up View 3 for the SOUTHST Profile 

1. In View 1, select the SOUTHST alignment. 

2. From the context menu, select the Open Profile View icon. 

3. Click in View 3 to open the active SOUTHST profile in that view. 

4. Hover over the Profile in the view. 

5. What is the name of the Active Profile?___________________________ 

6. Save Settings. (Leave view 4 blank for now.) 

7. Remain here for the next exercise. 
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PROJECT EXPLORER 

The Project Explorer interface (File > Project Explorer) is a useful tool for examining, modifying and 

viewing the features as the model develops. It provides a tree style view of the various items included 

in the design file, including the references. Many of the items in the Project Explorer can be Right-

Clicked for more options. The Project Explorer can be docked and pinned to the sides of the 

MicroStation interface for quicker access. 

Links – not currently used at MnDOT 

File – details elements contained in the current dgn and references  

Survey – details Survey elements contained in the current dgn 

Civil Model – details civil elements contained in the current dgn file and references  

Civil Standards – details about standards and project settings used in the current dgn and from library 

attachments 

 

The tabs available in the dialog are customizable by choosing Settings > Project Explorer. A typical 

MnDOT user should have the interface set as follows with the File and Links turned off. 

 

Hint:      The more familiar you become with Project Explorer the more successful you 
will be at learning the tools and structure of the model. 
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DESIGN STAGES 

When first creating a corridor, a Design Stage must be selected for the corridor. The design stage 

controls the frequency of calculations along the corridor, and also which corridor entities are written 

into the model. 

It is important to understand that in order to get accurate information from the model, the model must 

have an evaluation point at the desired location or else the information pulled out of the model is an 

interpolated value. If a model was created by making calculations every 50 feet, then information taken 

will be interpolated in-between, except those that align with the 50ft intervals. For that reason, the 

model should be set up to evaluate at the smallest reasonable interval. While this may not make much 

difference on a small project, larger projects may benefit significantly from a shorter processing time 

when reduced model accuracy is acceptable. At MnDOT that distance is 5 feet for most projects. 

To review design stages open the Project Explorer > Civil Standards Tab. Navigate through the 

Library Section  

 

In addition to controlling the number of corridor evaluations based on the Template Drop Interval 

Multiplier, the Design Stage specifies whether corridor evaluations occur at Critical Stations, Cardinal 

Points, and whether additional evaluations occur in the vicinity of curves. 

MnDOT has defined multiple Design Stages. Review and compare for specific differences.  

0-Functional - A processing interval multiplier of 10 and has no critical stations included.  

1-Preliminary - A processing interval multiplier of 5 and has most critical stations included.  

2-Design - A processing interval multiplier of 2 and has most critical stations included. 

3-Final - A processing interval multiplier of 1 and has most critical stations included. 

X-Final XXXXX – different iterations of the 3-Final that create more/less elements 

Note: Normally, the Template Drop Interval, entered during corridor creation, will be 
5ft, making the Preliminary Design Stage interval 25ft. 

Corridor processing will be faster, but the model will be a little less accurate for the 1-Preliminary 

design stage since the evaluation frequency is lower. Corridor processing will take longer, but create a 

more accurate model with the 3-Final stage. In addition to a higher frequency of corridor evaluations 

as controlled by the Template Drop Multiplier, the final design stage densifies the evaluations around 

curves. 

A typical workflow would be to step through the various design stages as a project is developed. The 

0-Functional would be used for planning projects, the 1-Preliminary Design Stage is selected when 

first building and refining the corridor, and so forth. 
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The Design Stage selection can be changed at any time by accessing the Corridor Properties via the 

Corridor context menu or by opening Element Information for the corridor element.  

 

 Create SOUTHST Corridor 

1. Select the Create Corridor icon from the Corridor Modeling task menu. 

 

2. Select 1-Preliminary for the Design Stage in the Create Corridor dialog box. 

3. Move cursor into view and away from the dialog box to reveal the floating prompt. 

4. What is the first prompt? __________________________________ 

5. Locate Corridor Baseline by left clicking on the SOUTHST alignment. 

6. Right click (reset) to select the active profile. 

7. Type SOUTHST into the next prompt to Specify Corridor Name. 

8. Left click to accept the name. 

The Create Template Drop dialog opens and the floating prompts now step through these entries. 

9. Follow the floating prompts as described in the table: 

FLOATING PROMPT USER ENTRY COMMENTS 

Select Template -  <Alt> 
Down to Browse 
Templates 

 Hit <alt> key and down arrow on the keyboard 

 In the Pick Template interface that opens, browse to 
ProjectTemplates > SOUTHST > SOUTHSTRural - 2 
Lane template 

 With desired template name highlighted and showing in 
the view, select OK 

 Confirm that selected template name is now in the floating 
prompt window 

 Left click to accept entry 

 

Start Station - <Alt> Lock 
to Start 

 hit the <Alt> key 

 Left click to accept the entry 

The station entry changes to 10+00.00 R1 and a 
padlock icon appear indicating this entry is locked 
and will no longer respond to a graphical selection. 

End Station - <Alt> Lock  Move cursor to end of alignment. Any station location may be keyed in or graphically 
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to End  Confirm that the station entry matches the end station 
22+03.76 

 Left Click to Accept the entry 

selected in the station selection prompts. 

Hitting <Enter> on the keyboard will lock the entry. 

Interval  Enter  5 for the Drop Interval  

 Left Click to accept entry 

If the pre-filled entry is correct, simply right click to 
accept it. 

Start Transition  Minimum Transition Before Drop = 0 

 Left Click to accept entry. 

 

Stop Transition  Minimum Transition After Drop = 0 

 Left Click to accept entry. 

 

The corridor processes as indicated by a progress graphic at bottom of the view. 

The Create Template Drop dialog remains and the floating prompt returns to the template selection 

option allowing for the addition of more templates. 

10. Right Click to Exit the tool 

11. With view 1 active (Default Model), turn off the self-reference to the 3D-Default Model. 

Notice the following in View 1: 

  A corridor graphic appears surrounding the alignment. This corridor outline follows the resulting 

construction limits. It is selectable and a corridor context menu is associated with it. 

 A Template Drop graphic appears around the alignment.  The template drop graphic is selectable 

and has an associated context menu. 

 

Also, notice the view of the 3D model in View 2. 

 

12. Remain here for the next exercise. 
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CORRIDOR AS AN ELEMENT 

When the corridor is created, boundary elements surround the entity. At MnDOT these elements are 

construction class elements so that they can easily be turned off with the view attributes. 

The Corridor graphic element is placed on the CORR level. It contains basic information such as the 

name, design stage, alignment and profile information. These can be modified using element 

information or the Project Explorer. The corridor graphic is used as input for multiple tools. 

The Template Drop graphic element is placed on the TMPL level. It contains the templates, station 

limits and interval for the drops. 

The Single Station Drop graphic is much like the template drop. It designates a single station drop in a 

corridor.  

The Transition graphic depicts the area between templates where a transition occurs. This area can be 

edited to control how changes occur between template drops. There must be a gap between sections to 

create a transition.  

REVIEW CORRIDOR INPUTS 

Once a corridor is created, it will be an iterative process to review and refine it. The corridor reviewing 

tools will be introduced first, and then the corridor refinement tools. 

There are several ways to examine and review the corridor and corresponding 3D model. The Project 

Explorer tree view and the Corridor Objects interface each show what has already been incorporated 

into the model. Most corridor inputs are available in both the Project Explorer and the Corridor 

Objects, but a few items are found in only one or the other. 

In addition to the interactive interfaces, a report version of the various corridor inputs can also be 

created and saved for reference outside of the design file. 

Within Project Explorer, information about the corridor(s) is found under the Civil Model > 

Corridors heading. Generally a pop-up menu is available via a right-click on the various list items. 

 Review Civil Model in Project Explorer 

1. Open the Project Explorer (File > Project Explorer). 

2. Click on the Civil Model tab. 

3. Using the plus signs, expand the tree down to: Civil Model > Civil Data > d340814_cm.dgn 

> Linear Elements 

4. Left Click to highlight the element Complex Element: SOUTHST. 

5. Notice that the SOUTHST alignment highlights in the view. 

6. In Project Explorer, Navigate to: Civil Model > Civil Data > d340814_cm.dgn > Corridors > 

SOUTHST > Templates. 

What range does template drop cover?________________________________ 
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CORRIDOR OBJECTS 

Once a corridor has been created, the Corridor Objects interface is available via the “bucket” icon in 

the Corridor Modeling tool set. This interface provides access to the items already included in the 

corridor, as well as access to the command to add new items to the corridor. 

 

Within the dialog, color coding is used to depict the status of objects. For example, if a template drop 

is out of sync with the attached library the name will display as Red. If the template is missing from 

the library the name will display as Blue. 

Out of Sync Template: Red 

 

Missing Template in Library: Blue 
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 Review Corridor with Corridor Objects 

 

1. Open the Corridor Objects interface     

Civil Tools > Corridor Modeling > Corridor Objects 

Hint:      HINT – move cursor into view window to reveal floating prompt. 

2. Locate the SOUTHST corridor by left clicking on the boundary of the corridor. 

The Corridor Objects interface opens. 

 

3. Which categories currently contain corridor objects?____________________ 

4. What is the Station Range of the template drop? _________________________ 

Note: The External Reference and Clipping Reference lists appear in the Corridor 
Objects interface only, not in the Project Explorer Corridors list. 

5. Close the Corridor Objects interface. 

 Generate the Design Input Report 

The Design Input Report icon opens the Bentley Civil Reports Browser to a report which lists all of the 

inputs to the corridor. This report can be saved in a variety of formats so that it can be reviewed 

outside of the design file. 

1. Open the Design Input Report dialog.   

2. Graphically Locate the SOUTHST corridor. 

3. The Roadway Setup Report opens in the Bentley Civil Report Browser. 

4. Scroll down in the report to view the various sections. 

5. Currently the only entry is in the Template Drops section. 
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6. Close out of the report browser window. 

7. Remain here for the next exercise. 

REVIEW CORRIDOR RESULTS 

The terms Corridor and 3D Model are somewhat interchangeable because creating a corridor 

automatically generates a corresponding 3D model. The corridor is where the various design details are 

defined and edited. As each detail is defined or changed, it becomes part of the 3D Model. Cross 

sections, proposed terrain model, break lines which can be used for construction and other design 

details may all be extracted from the 3D model. 

3D Model Visualization, Dynamic Cross Sections and using Civil AccuDraw to view location 

information are ways to examine the model after it had been created. These can all be accessed at any 

time after a corridor has been created, and can be used to review the model as refinements are made. 

DYNAMIC CROSS SECTIONS 

Dynamic cross sections offer a cross section view of the 3D model and are available immediately 

within this design file once a template has been dropped into the corridor. 

 

The view properties 

Note: In order to complete earthwork calculations, cross sections still need to be 
exported from this file into a traditional GEOPAK cross section file. The 
earthwork cross sections are generated with a different tool than the dynamic 
cross sections. 

Note: Dynamic views are slow, be patient. This goes for profile and cross sections. 
Turn off if unnecessary. 

 Open Dynamic Cross Sections View 

1. Select the Open Cross Section view icon and follow the floating prompts: 

a. Locate the alignment or corridor: Graphically Select SOUTHST corridor 

b. Select or Open View: Left Click within View 4 

2. Zoom in on cross section view. 
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3. Open the View 4 View Properties  

4. Toggle on Center on Current Offsets. 

5. Set the Vertical Exaggeration to 2. 

6. Left Click on the right and left arrow buttons at the top of the view to step forward and 

backward through the cross section stations. 

The blue line moving along the Plan (view 1), 3D model (View 2), and Profile (View 3)  view 

indicates the location of the current dynamic cross section. 

 Select Dynamic Cross Section Location via Data Point  

 

1. From the Corridor Modeling task menu, select the Locate Station Via Data Point icon. 

2. Move cursor into the Plan View (View 1) to reveal floating prompts. 

3. Single Left Click on the boundary of the corridor to locate the SOUTHST corridor. 

4. Key-in or graphically select station 15+80.00 and left click to accept. 

5. Move the cursor to the dynamic cross section view (4) and left click to select it. 

Dynamic Cross Sections update to the selected location. 

TEMPORARY DIMENSIONING 

 

Within the dynamic cross section view, it is possible to place temporary dimension lines which aid the 

designer in reviewing the corridor model sections. These dimension lines represent horizontal 

distances and slopes between user-designated points. None of these dimensions will be saved. 

Note: Temporary dimension lines are only retained for the active MicroStation session. 
They update if the corridor is reprocessed, but do not hold from one session to 
the next. 
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Hint:      Make sure to use snaps when issuing data points to ensure accurate 
placement. 

  

Labels can be removed using the “Remove Temporary Dimensions” tool. 

 Add Dimension Labels to Dynamic Cross Section View 

Label the lane and shoulder as the figure above. 

1. From the Corridor Modeling Task Menu, select the Show Place Dimension icon. 

2. Move the cursor into View 4 to reveal the floating prompt; left click to select view 4. 

3. For the Start Point prompt: move the cursor toward the centerline point until the vertical 

indicator snaps to the centerline point. Left click to set centerline as the starting point for the 

dimension label. 

4. For the End Point prompt: move the cursor to the right of the centerline until the vertical 

indicator line snaps to the right lane point, left click to set lane edge as the ending point for 

the dimension label. 

5. For the Dimension Height: move the cursor up and down in the view window until the 

dimension label is at the desired height. 

6. Place dimension labels for each lane and the shoulders. 

7. Use arrows to move through the cross sections; the labels remain as the station changes. 

8. Right Click to close the tool. 

CIVIL ACCUDRAW AS A REVIEW TOOL 

The Civil AccuDraw tools provide a way to determine station and offset information from the cursor 

location. Sometimes the user may wish to verify point locations in the plan view, perhaps to identify 

key station locations. 

Depending on the active MicroStation window, the Civil Accudraw may display more or less options. 

The shortcuts may not work the same or be the same as MicroStation Accudraw. 
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Warning: Do not have MicroStation Accudraw and Civil Accudraw running at the 
same time. They will conflict and it will cause issues. 

1. Toggle Civil AccuDraw on. 

2. Left click in the Plan View (1) to activate the horizontal Civil AccuDraw tools. 

3. Activate the Station-Offset tool. 

The Civil AccuDraw toolbar should look like the figure below. 

 

 

 

4. Open the Civil AccuDraw Settings dialog using the second icon from the left. 

5. In the Operation tab, check  the Show AccuDraw Dialog  on. 

6. Close the Civil AccuDraw Settings. 

7. In the Civil AccuDraw Dialog, left click on the target icon as highlighted in the figure. This 

allows a graphical selection of the alignment for which stationing information will be shown. 

 

8. Click on the SOUTHST alignment and confirm that SOUTHST appears in the dialog box as 

the Element. 

9. Move the cursor around the view window and notice the Station and Offset entries changing 

in the Civil AccuDraw Dialog box. 

10. Select one of the Horizontal Geometry drawing tools such as Line Between Points. 

11. AccuSnap should be active, so that the Station and Offset entries will match snappable 

locations when the snap icon is showing. 
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12. Close the Civil AccuDraw dialog. 

13. Toggle Civil AccuDraw off. 

14. Notice that the cursor dynamically displays information that was in the dialog. 

15. Close and check in files. 

3D MODEL VISUALIZATION 

One obvious way to examine the 3D model is to visualize it in 3 dimensions and use various viewing 

tools to rotate, pan and zoom in on the model. 

Turning levels On/Off can aid in viewing specific objects or break lines created in the model.  

Warning: The feature definitions category of the Civil Standards in Project Explorer 
offers view control of objects in the file. Feature Definitions that are turned off 
have NO method to display when referencing. Before exiting a file, make sure 
that all features are turned ON. 

Default materials are assigned to the features for simple visualization of the model. These are enabled 

by switching the display style in MicroStation. The intent of the assigned materials is to give a quick 

presentation style view without any additional effort by the designer. 

 Visualize the 3D model 

1. Click in view 2 to make it the active view. 

2. If necessary repeat these steps from the exercise to set up view 2: 

a. Zoom in on the SOUTHST corridor. 

b. Select the Isometric View Rotation. 

3. Resize the view, if desired. 

4. Click and hold the Display Style List icon and select Smooth with Shadows. 

 

5. Turn on Line Weights in the View Attributes to clearly see the break lines. 

6. Use the Dynamic View Rotation to examine the 3D model. 

Hint:      Use AccuSnap to snap the position of the camera on to an element in the 
model to rotate about. 

7. Change the display style to Transparent with Shadows to visualize the 3D mesh. 

8. Window > Tile to make all 4 views visible. 
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The colors chosen for the features match the typical predesign colors for a standard MnDOT project. 

By disabling the materials in a display style and turning off some levels the TOP view could be used as 

the shape file for a predesign layout. 

 Create a New Display Style (Optional) 

1. Click Settings > Display Styles. 

2. Highlight the Smooth style. 

3. Click the copy icon. 

4. Rename it to Smooth - No Material. 

5. Toggle On the No Material Override. 

6. Apply it to the model. 
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4 

4 
INTRODUCTION 

As previously noted, working with the corridor/3D model will be an iterative process. When a corridor 

is created it may be simple or complex. Common revisions to a simple corridor include adding 

templates, editing the templates already in use, adding graphic or value-driven controls and adding 

superelevation. The effects of these changes can be reviewed nearly immediately. 

The Corridor Objects interface was introduced earlier. Now it will be used to monitor corridor 

changes. 

REVISE TEMPLATES IN CORRIDOR 

Templates may be edited after they have been inserted into the corridor. Template edits will be made 

within the project template library. Then the library and the corridor will be synchronized so that 

template library updates get pushed into the corridor. 

Note: Although it is possible to edit a template drop – that is to make changes to the 
template within the corridor dgn file - the MnDOT workflow makes all template 
changes within the project template library to ensure that the library copy is up to 
date. 

 Revise Template and Synchronize the Library with the Corridor 

There has been a change to the ditch design; the left ditch depth has changed from -4 to -2.75. 

1. Open the d340814_cm.dgn design file. 

2. Open the project template library. 

3. Double left click on SOUTHST-Rural-2Lane to open the template that was dropped  into the 

corridor. 

4. Left Click on the Active Template tab. 

5. Expand the Parametric Constraints folder. 

6. Double left click on the L_DTCH_DEPTH list entry to open the Edit Default Parametric 

Value dialog. 

 

7. Change the L_DTCH_DEPTH value to -2.75. 

8. Select OK to enter the value and close the dialog. 

9. Close the template library, select YES when prompted to save your changes. 
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10. Open the Corridor Objects for the corridor. Note how the template name color designates that 

it is out of synch with the library. 

11. From the Corridor Modeling task menu, select Synchronize Template. 

12. Follow the floating prompt to select the template drop in the Plan View, (View 1). (This will 

replace the template in the corridor with the edited template of the same name from the 

library). 

13. Review the model and/or dynamic cross sections to see that the change has been incorporated. 

14. Since this change was made within the template, there is no change in the Corridor Objects 

interface. 

Note: While not needed at this time, in order to switch from one template to another, 
use the Pick Templates icon to the right of the template name in the Corridor 
Objects Template Drop interface. 

 

15. Remain here for the next exercise. 

TARGET ALIASES 

Target aliasing allows end conditions to target a terrain model or corridor features in a prioritized list. 

This is the solution when there are multiple terrain models in a corridor or you want an end condition 

to target another corridor like a ramp or pond. 

 

Note: At this time, target aliases do NOT work with overlay/stripping components. You 
could not use this method for inplace topsoil or inplace pavement stripping. 
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 Target Alias 

For the exercise, an addition terrain model was created from the project terrain model by bringing the 

voids as Island Features. The terrain model is then added as a secondary target alias. 

 

1. In the d340814_cm.dgn. 

2. Attach the reference file d340814_dtmVoid.dgn as a reference to the Default Model. 

3. On the Corridor Modeler task menu, click the Target Alias tool.   

4. Locate the SOUTHST corridor 

5. Add the both the terrain models as as Active Surface Targets. 

6. Click OK. 

7. The corridor updates to reflect the end conditions that can now solve. 

INSERT GAP 

One way to manage an intersection in a corridor is to have a gap in the corridor where there is no 

template.  In this example, the same template is used on both sides of the intersection. In previous 

versions, an empty/null template without components may have been used or a new corridor. 

 Insert a gap across the intersection 

1. Highlight the template drop boundary to reveal the Template Drop Context Menu. 

 

2. Select the middle icon, Copy Template Drop. 

The Create Template Drop dialog and floating prompts ask for the start and end stations for 

the new template drop using the copied template.  

3. Snap to the center of the right side curb return to select the starting point of the template drop.  

 

4. Left Click to accept the starting point station entry. 
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5. Hit the <Alt> keyboard key to lock the end station to the end of the alignment. 

6. Left Click to accept the end station entry. 

7. There is now a boundary line across the alignment indicating where the first template drop 

end and the second template drop begins. 

8. Highlight the first template drop. 

 

9. Place the cursor at the handler arrow near the end boundary of the template drop. 

10. Left click on this arrow and drag back to the center of the curb return on the other side of the 

alignment. 

11. Release the mouse. 

 

The template drop boundary adjusts and there is now a gap with no template across the 

intersection. 

 

12. Look at the Corridor Objects Interface. 

How many Template Drops are listed?________________________________ 

What are the template names?________________________________________ 

13. Pan along the 3D model in View 2 and see that the model also has a gap. 

14. Remain here for the next exercise. 
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DEFINE PARAMETRIC CONSTRAINTS 

Parametric Constraints are utilized to set project-specific values for depth, widths, or slope of template 

elements that are not part of the typical section.  They may be applied within a specific station range 

along the corridor or for the length of the corridor. Where defined, Parametric Constraints override 

the corresponding template default values.  Parametric constraints correlate to redefinable variables in 

the classic GEOPAK workflow. 

Review the typical section “Notes” to find that the ditch width varies from 8 feet at the beginning of 

the alignment to 6 ft. at STA 15+25.00. This variation can be handled by defining a Parametric 

Constraint within the corridor. 

 Add Ditch Width Parametric Constraint 

1. Select the Define Parametric Constraint tool from the Corridor Modeling task menu. 

 

2. Use the table to make the floating prompt entries: 

 

Locate Corridor  graphically select SOUTHST corridor  

Start Station - <Alt> Lock 
to Start 

 Lock to start of alignment; Left click to accept the entry The station entry changes to 10+00.00 R1 and a 
padlock icon appear indicating this entry is locked 
and will no longer respond to a graphical selection. 

End Station - <Alt> Lock 
to End 

 Key in 15+25.00; Left Click to Accept the entry Any station location may be keyed in or graphically 
selected in the station selection prompts. 

Hitting <Enter> on the keyboard will lock the entry. 

Constraint Label  Move into the Create Parametric Constraint dialog 

 Open the Drop Down Menu for the Constraint Label 

 Select R_DIT_WIDTH 

 Move back into the view window to see the floating prompt 

 Confirm that the selected label is showing in the prompt 

 Left click to accept entry. 

Using the down arrow in the floating prompt will 
scroll through the Constraint Labels available in 
the corridor. The list is long so working in the 
dialog box may be more efficient. 

Start Value  Key in 8; Left Click to accept  

End Value  Key n 6; Left Click to accept  

3. Close the Parametric Constraint dialog. 

4. In the Dynamic Cross Section view, return to the starting station. 

5. Note the green box around the outside ditch bottom point. This indicates that a Parametric 

Constraint has been applied to that point. 

6. Dimension the right ditch width to confirm that it now varies. 
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7. Review the Corridor Objects interface. 

What has been added to the Corridor Objects interface information?_____________________ 

Note: When working with numerous Parametric Constraints on the same point, review 
the Corridor Objects listing carefully to ensure that the constraint ranges do not 
overlap.  

Note: Right clicking on the column headers in Corridor Objects allows sorting to aid in 
reviewing and checking the Parametric Constraint entries. 

Note: The Parametric Constraint tab within the Corridor Objects interface includes 
icon commands for importing and exporting Parametric Constraints. Parametric 
Constraint value tables can be created outside of the design file and then 
imported. And, Parametric Constraints used within the corridor can be exported 
for review or other use outside of the design file. 

ACTIVATE HORIZONTAL FEATURE CONSTRAINTS (PLAN GRAPHICS CONTROLS) 

The modeling tools are able to utilize selected MicroStation elements to determine the presence and/or 

position of design components, such as shoulder widths. It requires that the graphics are a GEOPAK 

feature and being set as a corridor reference. 

In order for a template to respond to plan graphics, these things need to be in place.  

 Within the template, the Horizontal Feature Constraint for the point must be toggled on with a 

Feature and Search Range defined. 

 The plan graphics must be drawn with the correct Feature Definition and located within the 

specified search range. 

 The plan graphics Features must be added to the corridor as references. 

The MnDOT templates are set up with Horizontal Feature Constraints defined so that plan graphics 

can be used to control point locations. 

If the Feature Definition for a plan graphics element is incorrect or missing, the Features Toggle Bar is 

used to add or correct it. 

 

The following table provides the correlation between a graphic feature and the point it can control for 

the rural template used in this project:  
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TEMPLATE POINT: MAY BE CONTROLLED BY 
GRAPHIC FEATURE: 

L/R_LANE_TO LANE 

L/R_TURN_TO TURN 

L/R_SHLD_TO SHLD 

L/R_PI_TO SHLD-PI 

To add plan graphics elements to the corridor, the Add Corridor Reference command is used. Once 

the graphics are referenced, they appear in the Corridor Objects interface as External References. If 

plan graphics elements have been added to the corridor, they will override the template default values 

as well as any parametric constraints on the point that they control, provided the plan graphics are 

located within the range specified in the template. 

Note: The search range for the Horizontal Feature Constraint begins at the location of 
the point prior to applying the feature constraint. The search range may be 
constrained to one direction. Therefore, situations can arise in which the graphic 
feature is present, but not found, because the template constraint or a 
parametric constraint places the point beyond the graphic feature relative to the 
search direction. 

Note: Setting the range to 0 causes the point to search indefinitely in both directions, 
without regard to the position of the centerline. While this may be desirable in 
some instances, it can cause a component to find features on the opposite side. 

Note: Currently all targeted graphics should reside in the same file as the corridor. 
This requires copying in graphics to the file from the construction plan and they 
will not dynamically update. 

 Set a feature on MicroStation element 

1. Open d340814_cm.dgn. 

2. Turn on the d340814_cp.dgn reference snap and locate. 

3. Copy the 4 intersection radii into the file from the construction plan. 
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4. From the General Geometry Task menu, turn on the feature toggle bar. 

5. In the pull-down, select Linear > Geometry > LANE 

6. Depress the Use active feature toggle. 

 

7. From the General Geometry Task menu, select Set Feature Definition. 

8. Verify the settings as follows: 

 

9. Select the intersection elements in View 1, if not previously in a selection set. 

 

 Add SOUTHST plan graphics as Corridor References 

1. Click in the Plan View (View 1) to make it the active view. 

2. Turn off visualization of all references to the active design file. 

3. In the Dynamic Cross Section view, add a dimension label to the left lane if there is not a 

dimension label already there. 

4. In the Plan View, make a selection set of the graphics for the SOUTHST corridor. 

5. Select the Add Corridor Reference icon. 
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6. Select the SOUTHST corridor. 

7. Right Click in response to the prompt: Data Point to Apply References to the 4 Selected 

Elements 

8. Go into Corridor Objects > External References. 

This list is now populated with each element that has been assigned a Feature Definition. 

9. Hover over the four LANE elements in the plan view to see that their names match those 

added to the External References list. 

10. Open Project Explorer. 

11. Left click on the elements in the list with a red Complex By Elements icon in front of them. 

Notice that they become highlighted in the plan view.  

Highlighting the element within Project Explorer is one way to find the location of a plan 

view element. 

12. Review the Dynamic Cross Sections. 

How did the left lane change? _________________________ 

CREATE SECONDARY ALIGNMENTS 

A secondary alignment may be used to more accurately model the area around a curved pavement 

edge. With a secondary alignment defined, the model will be evaluated along a line perpendicular to 

the alignment, then after intersecting the secondary alignment, the pattern line changes direction to be 

perpendicular to the secondary alignment.  

 Make the pavement edges around a curb return into secondary alignment 

1. Set the Display Style for the Default 3D view to Transparent With Shadows. 

2. Zoom in to view the curb returns. 

3. Select the corridor in plan view to reveal the corridor context menu. 

4. Open the corridor properties with the first icon. 

5. Change the Design Stage to 3-Final. Notice how the mesh in the 3D model changed to be 

closer together. 

6. In the Dynamic Cross Section view, move to station 15+95. 

7. In Corridor Objects > Secondary Alignment, select the Add New icon. 

8. Locate the LANE containing the NW corner of the intersection as the Secondary alignment 

and Left Click to accept. 

 

9. Following the Floating Prompts: Lock to the start and end of the alignment for the start and 

end stations, and use 0 for the offsets. 
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10. Watch what happens to the mesh in the 3D model, and to the tie slope width in the Dynamic 

Cross Sections with and without the secondary alignment. 

Hint:      Use Undo and Redo to review the difference between the model with and 
without the secondary alignment. 

11. Make the other LANE lines into secondary alignments. 

ASSIGN POINT CONTROLS 

Within the template, a point has its original default location. Within the corridor, a point with a 

Parametric Label may have a Parametric Constraint assigned to it which overrides the original template 

constraints.  If a template point has a Horizontal Feature Constraint defined, then graphics may be used 

to override the default point location and/or a parametrically defined point location. Constraints are 

defined within the template, and they take effect if the required information is found in the corridor. 

Do not use multiple methods to test the hierarchy of the controls if it can be avoided. Keep it simple. 

A Point Control is a constraint set up within the corridor (not within the template). When present, 

Point Controls overrule any Point Constraint definitions. They may be used to define the horizontal 

and/or vertical position of any template point. Within the MnDOT workflow these Point Controls are 

used to control special ditch grades, subgrade depths or trail alignments. Superelevation information is 

turned into point controls when assigned to the corridor.  

For all Point Controls, a station range may be specified, a Control Description should be entered for 

later identification, and the Point being controlled may be selected from a drop down list. 

Point Controls can be applied in as Horizontal or Vertical controls, or as controlling Both directions. 

This choice is the Point Control Mode. The remaining inputs required for creating a Point Control are 

dependent on which Mode is selected. The figure illustrates the Point Control entries for a Special 

Ditch Grade.  

Note: The parent/child relationship a template point controls how it will behave when a 
point control is assigned. If an incorrect point is chosen you may get undesirable 
results.  
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Once the Mode is selected, the options available for the Control Type are context sensitive. They 

include things like Linear Geometry, Feature Definition and Elevation Difference. In this case, the 

selection of the Vertical for the Mode with Linear Geometry for the Control Type, opened the field 

for Plan Element selection. With the alignment element SOUTHST selected, the Profile Elements 

available for that alignment become available for selection. 

The priority entry will create an order of application if multiple Point Controls are applied to the same 

point as the same station. The entry with the lower priority value will take precedence. Generally 

overlapping point controls should be avoided, though if carefully used they may resolve certain 

complex situations. Examine the point controls list carefully to check for overlapping station ranges. 

Offset entries are available for many of the Point Control types. They allow the user to offset the final 

point location from the location otherwise specified by the Point Control. If the start and stop offsets 

are different, the offset will taper linearly from the start value at the starting station to the stop value at 

the ending station. 

Point Controls are included in the Corridor Objects interface where they can be individually selected 

and edited or removed, if necessary. 

 Assign a Point Control to set a special ditch grade 

1. From the Corridor Modeling task menu, select the Create Point Control icon. 
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2. Using the figure below, fill in the Create Point Control dialog, or make the entries while 

stepping through the floating prompts. Make sure you change the Profile to the Ditch profile. 

 

When the entries are complete, the corridor will process. 

3. Close out of the Create Point Control dialog. 

4. Review the Corridor Objects interface. 

5.  Note the station location of the Special Ditch Grade profile in the Profile View (2) and move 

into that area in the Dynamic Cross Sections. 

Hint:      If using the Locate Station via Datapoint tool and the station lock is on, move 
into the Locate Station... dialog box and uncheck the checkbox. Now the 
station locator will respond to the cursor. 

Hint:      To key in a station value, move the cursor slightly so that the value shown in 
the Station entry floating prompt becomes highlighted, then key in the desired 
station. 

6. Examine the right ditch.  

Note the special indicator boxes around two of the ditch points. The green box indicates a 

Parametric Constraint is controlling the point location. The pink box indicates a Point Control is 

controlling the point location. 

7. In Corridor Objects > Point Control, use the drop down menu in the Enabled column to 

toggle the point control to False. 

What happens? _______________________________________________________________ 

8. Toggle the Point Control back to True. 

9. Put a temporary dimension label on the ditch inslope and step through a few sections. 

What happens to the ditch inslope slope value? ________________________________________ 

What happens to the ditch inslope width dimension? ____________________________________ 

Is this what is expected after assigning a Special Ditch Grade? ____________________________ 
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INSERT KEY STATIONS 

Additional stations of interest may be added to the model manually on an individual basis. This may be 

accomplished using the Create Key Station command which allows the Key Station to be specified by 

keying in a value or by graphical selection in the Plan View.: 

Key stations are included in the Corridor Objects interface where they can be individually selected and 

edited or removed, if necessary. 

 Assign Individual Key Stations at Drainage Feature Locations 

1. With the View 1 Plan View the active view, reference in the file d340814_dp.dgn. 

2. Locate the culvert along South Street. 

3. From the Corridor Modeling task menu, Create Key Station icon. 

 

4. Following the floating prompts, select the SOUTHST corridor. 

5. Move the cursor to the culvert location and Left Click to accept the location. 

6. Close the Key Stations tool by picking the selection tool.  

7. Open the corridor objects or dynamic cross sections to verify the station was added. 

What station is now included in the station list? _________________ 

8. Remain here for the next exercise. 

TRANSITION EDITING  

Template transitions occur between template drops with different points. To avoid an abrupt change a 

transition can be used to smooth the model and make connections to the points. The software attempts 

to connect the points, through point name overrides and component name overrides but there are cases 

where gaps can exist. 

Editing a transition is a two-step process. It is not easy to do on complex template and may take several 

attempts to get the desired result. The first step is to connect the points of the first template to the 

points of the second template. Points that do not connect are thicker + signs, whereas connected ones 

are thin.  

Note: End conditions are not shown. End condition transitions are handled through 
exceptions.  

Connecting Points 

A connection is created by clicking on an unconnected point on one template to another point on the 

other template. The connection line will be shown. To escape a connection, press the right mouse 

button.  

 The feature style used when the line is created in the surface will be the feature style of the first 

point selected.  

 A connection can be deleted by right clicking on it and selecting the Delete command from the 

pop-up menu.  

 To get a different view, right-click on one of its points, select Move Template and drag to a 

different location. The view tools also help clarify the connections.  
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 A template point can be connected to more than one point on the other template.  

Editing the Transition Components  

After connecting points and the OK button is selected, the component editor shows the results of the 

“best guess” of the connected points. You can modify the transition points as desired by clicking 

Cancel and returning to the Edit Transition dialog box. 

The display shows a cross section of the transition midpoint. The slider control at the bottom of the 

dialog box is used to adjust the location along the transition from beginning to end to make sure the 

transition is behaving properly. You can add a new component by right clicking anywhere in the view 

and selecting the points that define the component. To finish, right-click and select Finish.  

 When selecting points, you are limited to only the existing points, and cannot create new ones. 

  A component can be deleted by right clicking on it and selecting delete.  

 When everything is correct, select OK again to dismiss the dialog box. If you select Cancel at this 

point, you are brought back to the connect points window. 

END CONDITION EXCEPTIONS  

In many cases, it is desirable to keep the core/backbone of the road the same, but change the end 

condition. One could create a new template with the same backbone components and new or different 

end condition components; then, drop this new template at the appropriate station. The problem it is 

that likely 1) it creates template transitions that must be resolved, 2) the conditions on the left and right 

sides may be in different locations. This could lead to many templates to meet all the combinations 

(also numerous template drops). The solution to this situation is End Condition Exceptions. End 

condition exceptions come in three classes: overrides, transitions and backbone only. 

 

 

END CONDITION EXCEPTION OVERRIDES  

Overrides allow you to replace or override the template drop end conditions on the left or right of the 

backbone. You must edit the override or set up the new end condition. When the override exception is 

edited, the Create Template command dialog box is displayed allowing you to edit the end-condition.  

Using this method, one could set ditch depths or slopes instead of using parametric constraints. 

Another possibility is to force a desired result instead of letting the priority of the end conditions 

control it. 

END CONDITION EXCEPTION TRANSITIONS 

This style of override is used to resolve transitioning between end conditions. MnDOT uses point and 

component name overrides to limit the amount of transitions.  

 An example would be between a ditch and fill section if one wanted it to warp other than the default. 

Another example is when a user would like to transition between a 1:4 inslope and a 1:2 inslope over a 

certain distance rather than the default template drop. 
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END CONDITION BACKBONE ONLY 

This type of exception removes the end condition from the roadway so that only the core remains. It 

can be useful for eliminating end conditions at driveway entrances or intersections. 

 

 

 End Condition Exception – Override Ditch to Tieslope 

 

1. Click the End Condition Exception from the Corridor Modeling Task Menu.  

2. Select the SOUTHST corridor. 

3. Follow the prompts and fill in the information. 

 Name: R_FillSlope 

 Apply ECE To: Right Override 

 Start: 14+75 

 Stop: 16+50 

4. In the Edit End Condition dialog, Right Click and select Delete Components. 
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5. Hold the left button down on the mouse and draw a line to delete the ditch components. 

6. Once deleted, add the new End condition R – Cut/Fill from the library. Use the snap point 

R_PI_TO as the connection. 

7. Merge any duplicate points. Right-click on the R_PI_BO point and select merge. 

8. Choose the point with the appended 1 to delete. 

9. Click OK. 

10. The model processes and the fill slope should now be used if it solves. 

11. Check the Corridor Objects, under the category End Condition Exception, review the 

stationing and make any edits. 

 

 End Condition Exception – Transition from ditch to fill – Defined distance 

This method may be desirable to lengthen the transition when going from a ditch to tieslope, rather 

than using the default template drop interval. 

 

1. From the Corridor Objects, End Condition Exception, click the Add New Button. 

2. Follow the prompts and fill in the information. 

 

 

3. Right-click on a green point and select move template so that it is easier to distinguish the 

separate template drops. 

4. Connect the ditch points to the Tie points. 
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5. Click OK 

6. Using the Edit Transition Midpoint, verify how the transition is behaving using the Start and 

Stop slider. 

Note: There are right-click options available for editing if a component is to be added 
or removed. Only current points that reside in the template are available when 
adding a new component. 

Warning: The current version has a bug when attempting to add a new component 
through transitions. The appropriate feature definitions are not available. 
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7. Click OK and review the transition. 
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5 
INTRODUCTION 

Superelevation will generally be developed in a separate 2D design file. This gets referenced into 

working design file. The MnDOT naming convention for this file is project_sh.dgn. Superelevation for 

all alignments will typically be contained in a single superelevation file. On simple projects where 

there is a single alignment the superelevation should be contained in the same file as the corridor. 

Note: At this time, all superelevation information is stored in the same file as the 
corridor. This is due to software limitation if a reference is missing or updated. In 
the next Bentley release superelevation will be changing. 

PREFERENCE 

When working with superelevation, there are new visualization preferences which may be specified 

within the MicroStation Workspace Preferences.  

 Color Shaded Fill fills the superelevated areas with varying colors indicating normal crown, 

maximum superelevation and transition areas. The shading color will be solid until the 

superelevation transitions are calculated. 

 Boundaries Only shows the superelevation boundaries with manipulators which allow 

editing. 

 None removes visualization of the superelevation without removing the superelevation 

calculations. This can protect from accidental selection and manipulation of the 

superelevation. 

Note: Color Shaded fill may slow down the PC on a large project. 

 Review Superelevation Settings 

1. Open d340814_cm.dgn. 

2. Review the Superelevation Settings by navigating to: 

Workspace > Preferences > View Options – Civil > Superelevation Settings 

Set the preference to Color Shaded Fill. 

3. Review the Civil Formatting Station Settings by navigating to: 

MicroStation >Settings > Design File > Civil Formatting > Station Settings 

a. Format: ss+ss 

b. Precision: 0.12 

c. Equation: By Index 

4. Review the Civil Formatting Profile Settings by navigating to: 

MicroStation >Settings > Design File > Civil Formatting > Profile Settings 

a. Slope Precision: 0.12  

(Used for superelevation manipulators and cross slope of superelevation lanes) 
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SUPERELEVATION WORKFLOW 

The normal workflow for creating and applying superelevation is laid out in the superelevation tool set. 

Each task has an icon, allowing the user to stop and start work on superelevation at the various steps. 

The icons appear in the common order of use, making it simple to recall the order of work.  When one 

task is completed, the software automatically moves into the next step of the workflow.  

 

In order of appearance, these icons initiate the following tasks: 

 Create Superelevation Sections: define the segments of the alignment where superelevation will 

be calculated. 

 Create Superelevation Lanes: defines lane widths, side of centerline, and normal cross slope 

value. 

 Calculate Superelevation/Import Superelevation: specifies the applicable superelevation 

standard and the design parameters needed for superelevation calculations. 

 Assign Superelevation to Corridor: Apply the calculated superelevation to the corridor. 

 Insert Superelevation Station/Cross-slope: A superelevation editing tool. 

 Open Superelevation Editor: A tabular editing tool with a superelevation plots for reference. 

 Generate Superelevation Reports: Generates reports for immediate review or which can be 

saved and reviewed outside of GEOPAK. 

Within the specified station range, superelevation sections are created for each curve.  Curves which 

are closer together than the user specified Minimum Tangent Length value will be joined together 

into a single superelevation section. 

Clicking on the section outlines reveals and superelevation annotation: transition stations and cross 

slopes at key superelevation locations. Zoom in on the alignment to see the annotation clearly. 

For most jobs it is easiest to view the entire corridor as 1 superelevation section. For this case, set the 

Minimum Tangent Length to a large number like 100,000. 

Superelevation lanes hold the basic information about the superelevation configuration including side 

of centerline, normal lane width, relative location of the pivot point to the alignment, and the normal 

cross slope. 

Superelevation calculations are made based superelevation standards and project design parameters. At 

MnDOT, the superelevation standards use the same superelevation files that have been used to support 

superelevation in previous versions. 

Superelevation uses the active MicroStation settings for symbology. 

 

 Create Superelevation Sections 

1. Set the element Template to zDefaultGraphics>SUPER to set the symbology for the 

superelevation. 

2. Select Create Superelevation Sections from the Corridor Modeling Task Menu and follow 

the floating prompts: 
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a. Name (of superelevation section): SOUTHST 

b. Locate Reference Element: graphically select SOUTHST alignment 

c. Start Station:  Use <Alt> key to lock to start, Left Click to accept 

d. End Station : Use <Alt> key to lock to end, Left Click to accept 

e. Minimum Tangent Length: 100000. 

One superelevation section has been created. It is indicated by the wide boundaries 

surrounding the alignment. Notice that the entire alignment is combined into a single 

section because of the large minimum tangent length set. 

f. The software moves immediately into the Create Superelevation Lanes tool. 

Remain here for the next exercise. 

  

 Create Superelevation Lanes 

1. Enter the following information into the Create Superelevation Lanes dialog. Alternately, 

skip filling in the dialog box and enter the information directly at the floating prompts. 

 

2. Confirm and accept these entries in the floating prompts. 

3. The left lane fills in to show that it has been created. The fill is a solid color fill until 

superelevation transition calculations are made. 

4. Enter the following information for the Right Side. 
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1. Right Click to exit the tool. 

The Calculate Superelevation dialog opens. Remain here for the next exercise. 

 Calculate Superelevation 

1. Click ALT+Down and select the mndote.sep from ProjectWise: 

pw:\Documents\CADDStandards\MnDOTStandards\DOT_GEOPAK\preference\superelevati

on\ 

2. Make the following entries in the Calculate Superelevation dialog: 

 

3. Accept these entries with the floating prompts. 

Upon completion of these inputs, the superelevation will calculate and the fill color will 

become shaded indicating where the superelevation is transitioning. 

4. Right click to exit tool 

5. Notice the following: 

 The SOUTHST corridor Plan View shows superelevation lanes with a variable colored 

fill. 

 Outlines appear out beyond the corridor boundary. These are the superelevation sections. 

These outlines are used for selecting superelevation sections. 

6. Bring up the Civil Message Center. 

7.  Review the MicroStation messages to review the messages related to superelevation 

calculation. 
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EDITING SUPERELEVATION 

Often the superelevation needs to be modified such that it hits a certain cross slope at a certain location 

in order to tie into a side street, for example. This is done within the superelevation design file using 

the Insert Superelevation Station/Cross-slope tool. 

INSERT SUPERELEVATION STATION/CROSS-SLOPE (INSTRUCTIONS) 

After selecting the tool 

1. Follow prompt to Locate Superelevation – Click on the superelevation lane to be edited 

2. Distance Constraint Type: none 

3. Slope Constraint Type: none 

4. Pivot About: Left Edge (for Right Lane, the left edge is the centerline) 

5. Transition Type: Linear 

6. Station : select the station graphically or by keying it in, then Left Click to accept entry. After 

the station is entered, a keyboard <enter> will lock the entry so that the cursor can be moved 

without changing the station entry. 

7. Cross Slope: key-in value 

8. Point Type: undefined type – this is used in reports only, not calculations 

At this point the floating prompts return to the first entry of the distance constraint – additional 

superelevation stations can be inserted by cycling through the prompts, or “reset” to exit the dialog and 

insert the requested superelevation station(s). 

INTRODUCTION TO SUPERELEVATION EDITOR 

The superelevation Editor tool opens superelevation for editing in tabular form.  

1. Select the Superelevation Editor Tool. 

2. Select the superelevation section to be edited 

3. A Superelevation Editor window opens, showing the name of the horizontal alignment in the 

window header. The editor opens into the superelevation section that was selected when the 

tool was opened, but other sections that belong to the alignment can also be accessed via the 

list of superelevation sections shown in column in the lower left. 

4. At the top of the superelevation editor window is a graphical representation of the 

superelevation. This diagram is a visual aid only, superelevation changes will be made within 

the tabular data shown in the lower section of the window.  The diagram can be toggled on 

and off using the green dot icon. 

5. As is common within many Windows and GEOPAK tables, columns can be resized by 

dragging, and information can be sorted, columns can be toggled on and off , and the view 

can be otherwise customized by right-clicking in the table header and selecting from the pop-

up menu. 

6. Making the actual edits involves simply locating where along the alignment the editing is 

required, clicking within the cell to activate it, and typing in the new information. Note that 

the sign  is required when entering data into the table. 

SUPERELEVATION EDITING OUTSIDE OF THE SUPERELEVATION TOOLS 

Many common superelevation editing tasks can be completed without invoking special superelevation 

editing tools. The most common options are to edit the superelevation annotations available on the 

screen, or to edit the superelevation properties available from the context menu . 
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MAKING GRAPHICAL MODIFICATIONS (INSTRUCTIONS) 

1. Select the superelevation section to reveal superelevation annotation on the screen. 

2. Select just one lane to see the annotation for that lane only. 

3. Dark triangles are shown along the alignment at transition stations. These are actually 

manipulators and they can be selected and moved graphically to change where that transition 

begins or ends. Drag a triangle to see what happens. 

4. Selecting the station value opens a dialog box which can accept a key-in entry for a precise 

station location. 

5. Similarly, the cross slope can be edited using key-in entries. Note that the +/- sign is 

necessary here, so be sure to note whether the superelevation should be positive or negative 

prior to keying in the value. 

CHANGING THE DESIGN SPEED (INSTRUCTIONS) 

1. Select the superelevation section where the design speed needs to be changed. 

2. Hover over the superelevation section indicator to reveal context menu 

3. Select Properties 

4. Select a new Design Speed. 

5. Notice the change in the color variation. 

Note: This will override prior superelevation edits which do not conform to the 
standard. 

 Review Superelevation File 

1. Select the superelevation section boundary. 

2. Zoom and review the cross slope and stationing. 

3. Modify a couple of stations to be rounded to a whole number. 

4. Select one of the boundaries and open the Properties from the context menu. The properties 

provide a summary of the design parameters used to generate the superelevation transitions. 

 

5. Select the superelevation section, choose the Superelevation editor.  

6. Review the data in the editor. 

The data in the editor is a tabular view of the superelevation. It can also be used to make edits 

and revise the super. 
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7. Close the editor. 

8. Remain here for next exercise. 

APPLY SUPERELEVATION 

Superelevation can be developed independently from the corridor and other design functions as soon as 

the alignment and superelevation design requirements are known. Superelevation can be applied to the 

corridor at any point after the corridor is created.  

 Assign Superelevation to the Corridor 

1. Select Corridor Modeling > Assign Superelevation to Corridor icon and follow the floating 

prompts:  

2. Locate First/Next Superelevation Section: Graphically select the superelevation section. Reset 

to complete. 

3. Locate Corridor: Graphically select the SOUTHST corridor. 

4. The Associate Superelevation window opens listing the “best guess” about how the 

superelevation should be applied to this corridor. Review and correct the following as needed 

to match the figure: 

 The Superelevation Object is the named superelevation lane. 

 The Superelevation Point is the point moved by superelevation. 

 The Pivot Point. 
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5. Select OK to accept the listed information and re-process the corridor. 

 Review Superelevation with Dynamic Cross Sections View 

1. Click in view 4 to make it the active view. 

2. Move the dynamic cross sections to a location at or near maximum superelevation (dark 

orange color, or use max superelevation stationing noted in the previous exercise) 

Notice that the Dynamic Cross Sections are now superelevated. 

3. Use temporary dimension lines to review the cross slopes. 

What is the current station? ________________________ 

What is the cross slope at this location? _______________ 

4. Turn off visualization of the superelevation.. 

5. Remain here for the next example. 

SUPERELEVATION REPORTS 

A superelevation report is easily accessible through the superelevation report icon.  By default, the 

Superelevation Data Report is opened with the icon. The report will  be organized by superelevation 

section and will contain the superelevation specifications used for the calculation: the standards 

filename, design speed, normal cross slope, etc. If superelevation was imported from a .csv file, then 

only the section name and horizontal alignment will be listed in the specifications area. 

Then the start and stop stations for normal crown and maximum superelevation are tabulated, along 

with the cross slope values under normal and superelevated conditions.  

 Generate a Superelevation Report for SOUTHST 

1. Select both superelevation sections using the MicroStation selection tool. 

2. In the Corridor Modeling  task menu select the  Superelevation Reports tool. 

 

3. Move cursor into the view window to accept the selection. 

4. The Superelevation Data Report opens in the Bentley Civil Reports Browser. 

5. Review the Superelevation Data Report. 

What is the station range of maximum superelevation? ____________________________ 
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6. Close out of the report. 

7. Save this report as SOUTHST_super.xls (optional). 

AUXILIARY LANE SUPERELEVATION – INFORMATION ONLY – LABS NOT COMPLETE 

Auxiliary lanes superelevation can be defined to either follow the adjacent lane or to take on a different 

cross slope than the adjacent lane. 

The current project/templates do not have superelevation auxiliary lanes unless multiple lanes on one 

side of centerline – superelevation is controlled in the turn lanes via rollover controls. The outside turn 

lane points do not have the superelevation flag set. To be able to use the superelevation created in these 

exercises, the superelevation flag needs to be checked on for the X_TURN_TO points. 

 

 Set SOUTHST Right Turn Lane to Follow Adjacent Cross Slope – Information Only 

1. Select the Create Superelevation Lane Tool 

2. Following the floating prompts, select the superelevation section, then enter the information 

as shown in the figure: 
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3. Right Click to exit tool. 

Upon completion we see a shaded auxiliary lane with the same color shading as the adjacent lane. 

 Set CR10 Left Auxiliary Lane to Constant cross slope – Information Only 

This example auxiliary lane is in two superelevation sections. An auxiliary lane needs to be created for 

each superelevation section such that the end station for one lane is the start station for the other lane. 

All other details about the superelevation lanes is the same for both lanes. 

1. Select the Create Superelevation Lane Tool 

2. Locate First Superelevation Section, Reset to select. 

3. Enter the following information: 

 

4. Exit the tool. 

5. Select the other superelevation section. 

6. Open the Create Superelevation Lane tool again and enter the following information:  
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The auxiliary lane graphics draw with constant color fill indicating the constant cross slope.  
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6 
OVERLAY PROJECT WORKFLOW 

An overlay project begins like any other modeling project in that the existing terrain model and the 

horizontal alignment are required in order to create the corridor. For an overlay project, however, the 

proposed profile can be developed within the corridor, so only the existing ground profile is required 

prior to creating the corridor model. When creating the corridor, specially designed overlay templates 

will be selected in order to be able to use the existing ground surface as a boundary for some of the 

quantities. 

The CR10 segment will be used to demonstrate the tools available for developing overlay profiles, and 

introduce MnDOT templates available for overlay projects.  

 

PRIOR TO SETTING UP THE CORRIDOR FOR OVERLAY 

The following steps will have been completed up to this point: 

1. Existing Terrain Model will have been created using survey or other data. This is stored in the 

project_dtm.dgn design file and attached as a reference into the active design file. This terrain 

model must also be set as the active terrain model. 

2. Horizontal Alignment defined. This is stored in the current working design file.  

3. Existing Ground Profile created and set as the active vertical alignment. This is stored in the 

current working design file. (The proposed overlay profile will be developed using the 

Vertical Profile Adjustment tool within the corridor.) 

Note: The alignments and corridor must be in the same design file on order to be able 
to use the vertical profile adjustment tool in an overlay project. 

4. Plan Graphics have been created and are stored within the current working design file 

5. Superelevation, if applicable, has been developed (Optional). 

CORRIDOR WORKFLOW FOR OVERLAY PROJECTS 

The workflow to create and refine a corridor model is essentially the same for an overlay project, 

except that the templates used will be overlay templates, and refinements to define the lane locations 

must be made prior to using the Vertical Overlay Adjustment tool.  

1. Select Overlay templates from the MnDOT template library and turn them in to project 

specific templates by setting template constraint values to typical section dimensions. 

2. Create a corridor using overlay templates. 

3. Refine the corridor to incorporate typical and variable pavement widths and superelevation.  

a. Add parametric constraints, graphics or point controls to set pavement widths where 

they vary from the typical section values added to the template(s). 

b. Add superelevation.  
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Warning: Correct pavement widths and superelevation must be in place prior to using 
the Vertical Overlay Adjustment tool. 

4. Use the Vertical Overlay Adjustment tool to develop an optimized overlay profile. 

5. Generate “deliverables” 

a. Preliminary cost estimate 

b. Preliminary quantities 

c. Staking reports  

d. Export vertical profile to GPK 

e. Traditional Cross Sections if included in the plan 

ITEMS UNIQUE TO OVERLAY PROJECTS 

An overlay project follow the same basic workflow steps as new construction project, there are two 

aspects of overlay projects that are not part of new construction projects. 

OVERLAY TEMPLATES 

The templates used in an overlay project need to be able to follow existing ground. This need is met 

with special stripping/overlay template components. MnDOT has used these specialized components to 

develop a suite of templates for use with overlay projects. In the MnDOT template library, these 

overlay templates are found in the OverlayWidenMillTemplates folder. Generally, users will be able to 

select a pre-created template from the MnDOT template library. 

OVERLAY PROFILE OPTIMIZATION 

When developing the proposed profile for an overlay project, the existing road surface may be 

compared to the desired material depths in order to develop a profile which optimizes the use of new 

materials and existing structure to meet the structural integrity, constructability and cost constraints of 

the project. 

The tool available for this is the Vertical Overlay Adjustment tool which aids in developing an 

optimized profile for the project. This tool is found within the Corridor Modeling task group, and it 

does require that a corridor has already been created for the project. 

OVERLAY/STRIPPING COMPONENTS 

Overlay templates contain a special type of component called an Overlay/Stripping component. This 

component type has the ability to trace existing ground (or another available surface) to create either 

the top, bottom  or both boundaries of the component. MnDOT overlay templates use the 

Overlay/Stripping components for the following template components: 

 A non-uniform  wedge component, PVMT-WDG, which fills in the gap between existing ground 

(or bottom of milling) and the upper pavement layers which are at the proposed cross slope. 

 A milling component, PVMT-MILL which may have uniform or variable thickness depending on 

whether milling occurs across the entire width or only where needed to achieve required overlay 

thicknesses with allowable milling depths 

 Inplace pavement,  L/R_PVMT-INP 

In addition, overlay templates are set up to accommodate up to two uniform thickness pavement layers 

above the wedge material. If only one material type is required, use the template with a single layer 

rather than zero out the component. The upper pavement layers are standard components, not 

overlay/stripping components.  
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 Exercise: Open and Populate Template Library (with overlay templates) 

1. Open the d8205111_cm.dgn design file containing the NB61 alignments and plan graphics 

attached. 

2. Create and Open a d8205111.itl project template library. 

3. Use the Template Library Organizer to copy the Overlay 1Layer - LaneTurn template from 

the MnDOT standard template library to the project template library. 

Note: Update Capture 

 

Note: Put copies of the original MnDOT templates into the same folder they came 
from. Use the ProjectTemplates folder later as you edit the templates with 
project specific information.  

4. Select OK and allow the itl to save and overwrite the existing project template library. 

5. Copy the template into the NB61 folder. 

6. Rename to NB61-Overlay. 
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 Exercise: Review Templates and Set Template Constraint Values 

1. Open the newly created NB61-Overlay template. 

2. Confirm that this new template is the Current Template by checking the Name of the current 

template. 

3. Click Activate Template Tab. 

4. Set the Lane and Turn lane widths to typical section values: 

L_TURN_W 0 

L_LANE_W -12 

R_LANE_W 12 

R_TURN_W 0 

5. Set the following pavement layer thicknesses: 

OVL-LAYER1_THK -0.250 ft (3”) 

6. Hover over the top line of the template between points CL_T and L_LANE_TO. 

What is the slope of that LANE? _______________ 

7. File > Save to save the changes to the template library. 

Hint:      Thickness or depth of overlay/stripping type components are controlled via 
Parametric Constraints after inserting the template into the corridor. These 
include the milling depth and the minimum overlay depth.  

Hint:       Additional changes can be made within the corridor by using Point Controls 
(Plan Graphics) or Parametric Constraints (discussed in previous Chapters). 

 

PROFILE FROM SURFACE 

The corridor requires an active profile for vertical. An existing ground profile will be used as a starting 

point. 

 

 Profile from Surface from 267+00 to 290+00 

1. Set the attached Terrain as active. 

2. On the Vertical Geometry task, click the Profile from Surface tool. 

3. Select the INPNB61 alignment. 

4. Right-click (reset) to use active surface. 

5. Follow the prompts or fill in the dialog as follows. 
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Warning: Make sure you give the profile a name. The Prompts do not allow you the 
chance to name it. 

6. After the profile is created. Verify that it is active using Element Info or the Profile view. 

OVERLAY CORRIDOR 

The overlay corridor will be created in the same fashion as any other corridor. It is important, however, 

that certain corridor refinements have been made prior to using the Vertical Overlay Adjustment Tool 

because the tool will compare the proposed surface to existing ground in order to create a profile which 

accounts for the desired pavement thicknesses. To do this, the pavement edges need to be correctly 

located, and superelevation must be applied. 

 Create the NB61 Overlay Corridor and Superelevation 

1. Create a Corridor along INPNB61 starting at the beginning to 290+00. 

 Use template from previous exercise. 

 Select the 2- Design Stage 

2. Create and apply superelevation. 

 Create superelevation section –267+00 to 290+00 

 Create 2 superelevation lanes – 16’ left and 12’ right. 

 Calculate Super – 

o Using Preference File "mndote" 

o Using e Selection of "High Speed". 

o Using Length Selection of "1:400 SF" 
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o Using Design Speed of 70.000000.  

 Apply superelevation to the corridor. 

3. Open the Model (view 2), Profile (view 3), and Dynamic Cross Section (view 4) views. 

4. Set Parametric Constraints for the Turn Lanes. 

 

5. Review and Refine the Corridor 

 Confirm that the lane widths and superelevation are correct. 

6. Remain here for the next exercise. 

INTRODUCTION TO OVERLAY VERTICAL ADJUSTMENT TOOL 

This section covers the background and methodology behind the Overlay Vertical Adjustment Tool.  

BACKGROUND AND METHODOLOGY 

Prior to adjusting the profile, the user must have inserted a template and all of the variables which 

define the extent and shape of proposed finished grade – for example lane, turn lane and shoulder 

widths and superelevation cross slopes. Then, via the Overlay Vertical Adjustment dialog box, the user 

specifies which combination of overlay and/or milling applies to the corridor, as well as pavement 

depth (backbone), minimum overlay thickness and milling depth. With this information, Corridor 

Modeler compares the final elevations of the Template Top (proposed finished grade) to the existing 

ground elevations and determines an adjusted profile which meets the specifications. 

The process of creating an adjusted profile is summarized below: 

 VERTICAL ADJUSTMENTS: THE METHODOLOGY 

 Given a template it determines the Template Top 

 This is the Triangulated Surface 

 Regardless of the complexity of the template, the Top is a simple left-to-right line string 

 It compares the vertices in the Top to the Vertices in the Active Surface. 

 It finds the Maximum (or Minimum) vertical difference value 

 It add the Backbone Thickness, Overlay and/or Milling value to determine an adjustment value 

 Adjustment is completely independent of anything other than the Top line and Surface 

Corridor Modeler compares elevations at several points across the cross section in order to find the 

critical point which determines the minimum required profile adjustment for that section. From the 

critical point, the Template Top is traced back to the PGL to get the PGL elevation for the adjusted 

profile. Later, the user has some options to smooth and manually adjust the proposed profile. 

For every comparison point the vertical difference between the existing surface and Template Top is 

calculated. Direction/sign matters: 

 There are only two comparison points that matter:  Zero Overlay Point and the Minimum Milling 

Point. 

 Positive = Existing Surface above Template Top 

 Negative = Existing Surface below Template Top 
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ZERO OVERLAYPPOINT 

 is used for Use Minimum Overlay options 

 is the highest point at which the overlay occurs across the full width of the Template Range 

 is located at the point where the difference is the highest value 

 Zero Overlay Delta = highest value (sign matters) 

MINIMUM MILLING POINT 

 is used only for the Use Minimum Milling option 

 is the highest point at which the milling occurs across the full width of the Template Range 

 is located at the point where the difference is the lowest value 

 Minimum Milling Delta = lowest value (sign matters) 

OVERLAY VERTICAL ADJUSTMENT SPECIFICATIONS  

The Overlay Vertical Adjustment is where the user specifies the design requirements related to 

adjusting the profile to accommodate an overlay/milling scenario. The settings specify where the 

design parameters get translated into and how the vertical profile adjustment will be calculated.  An 

understanding of these scenarios is particularly important. 

 

OVERLAY/MILLING SCENARIO SETTINGS 

There are three scenarios supported in the overlay tools which are specified within the Overlay 

Vertical Adjustment dialog as follows: 

 Overlay only (Minimum Mode = Minimum Overlay)  

 Overlay and Max Milling (Minimum Mode = Minimum Overlay, Use Maximum Milling checked) 

 Milling only (Minimum Mode = Minimum Milling, with or without Use Maximum Milling) 
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Each Scenario requires a value or parametric label for the Backbone Thickness. The Minimum 

Overlay Thickness and Maximum Milling Thickness values or parametric labels are needed only 

when those options are invoked. 

TERM DESCRIPTION PARAMETRIC VARIABLE 

NAME IN TEMPLATE 

Backbone 
Thickness 

Depth of fixed pavement relative to profile grade line. VERTADJ_BACKBONE 

Minimum 
Overlay 
Thickness 

Minimum thickness to be maintained between the backbone and 
the existing surface, including any new milling.  

MIN_OVERLAY_THK 

Maximum Milling 
Thickness 

Maximum vertical distance to mill out high spots in the existing 
pavement.  

CONST_MILL_THK 

Minimum Milling If the Minimum Mode is set to Minimum Milling, then the software 
identifies the location and adjustment required to provide a full-
section width of milling; the lowest vertical adjustment where the 
existing surface and backbone bottom intersect.  

 

If the backbone, overlay thickness or milling thickness vary along the corridor, Parametric Labels can 

be selected from the dropdown list and then the variable Parametric Constraint must be added to the 

corridor. 

These scenarios are illustrated below, followed by more detailed illustrations of the critical locations. 
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Minimum Overlay + Max Milling Adjustment Details 
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MINIMUM MILLING ADJUSTMENT DETAILS 

 provides milling across the full width of the Template Range 

 requires the least amount of milling for full-width milling 

 is located at the point where the difference is the lowest value (bottom-most) 

 the Minimum Milling “line” represents the bottom of the new template backbone 

 Minimum Milling Delta = lowest value (sign matters) 

When the Use Minimum Milling option is selected the Minimum Milling Point is found as the Critical 

Point. The Minimum Milling Delta is used in the adjustment calculations.  

 

OTHER OVERLAY VERTICAL ADJUSTMENT SETTINGS 

In addition to specifying the Overlay/Milling scenarios and design parameters, the Overlay Vertical 

Adjustment dialog has fields for the following information: 

VERTICAL NAME 

This is the name assigned to the adjusted profile to be created. 

START/STOP STATIONS 

The vertical adjustment may be limited to the specified station range. 
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LEFT AND RIGHT TEMPLATE RANGE POINTS  

When Corridor Modeler compares points for the profile adjustment, the comparison will happen only 

within the range specified by the Left and Right Point entries in the Template Range section. For 

example, by selecting the points at the lane or turn lane edges, the shoulders would not be considered 

when locating the critical point for profile adjustment. 

EXISTING GROUND RANGE 

There are a number of options for defining the width of the existing surface, or the Existing Ground 

Range, used in the adjustment calculations comparisons. 

 Match Template Range – the width of the template range will be used for the existing surface 

 Match Existing Linear Geometry or Feature Definitions - specify alignments or features to define 

the left and right range locations. The software will search the active surface and/or geometry 

project to find the objects. 

 Fixed Offsets – specify the range with left and right offset values relative to the corridor 

alignment. 

SOLUTION OPTION 

The Solution Option allows the user to adjust the resolution of the solution.  “Examine All Cross 

Section Points” will include all template points and existing ground points within the specified range., 

while “Examine Template Points Only” will make comparisons only at vertices in the template.  

 

The figure above shows the Adjustment Results for each method for a three point template. A red 

square indicates the critical point. The Template Points Only method ignores the “pothole” in road. 

MAXIMUM VERTICAL DIFFERENCE 

The Maximum Vertical Difference entry limits the range of adjustments. A Maximum Difference 

specifies that no vertical adjustment between processed stations will exceed this value (absolute). If 

this value is 0.0, the adjustment is not limited. 

OVERLAY ONLY - CREATE A PROFILE “RAISE” ADJUSTMENT 

This scenario raises top surface 3” from the highest existing ground point. The adjustment will likely 

be higher at the profile. 

 Scenario 1: Overly Only: Raise the profile by 3” minimum, with no milling and no minimum 

overlay defined 

1. First set Parametric Constraints for the pavement depths. This allows a confirmation of these 

values from within the corridor rather than having to go back into the template to confirm that 

they are in sync with the profile adjustment settings. 
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OVL-LAYER1_THK = 3” (-0.25ft.) 

2. Open the Element Information for the corridor. 

3. Verify that Use Active Profile is set to True. 

 

4. Select the Overlay Vertical Adjustment  tool from the Corridor Modeling task menu. 

 

5. Graphically select the corridor. 

6. Set the dialog values to match the dialog below. 

Warning: The new tools will allow a name that is not valid for the GPK. When 
naming profile, adhere to COGO naming restrictions. Do not use special 
characters and 15 character limit. 

 

7. Move the cursor into the view window to continue with the floating prompts and verify and 

accept the values from the dialog box. 

The corridor re-processes after completing final prompt. 

8. Locate the Profile in the Profile View. 

9. Using the Profile Context Menu, set the NB61R3 profile as the active profile. 

Note: Since Use Active Profile is set to True (step 3), the adjusted profile can be 
applied to the corridor by making it the active profile. 



Overlay Vertical Adjustment Specifications 

 

Copyright © 2015 Minnesota Dept. of Transportation  Overlay Vertical Adjustment Specifications 

4/16/2015  6-13 

Note: If Use Active Profile is set to False, then the profile would be changed by 
accessing the Corridor Settings and selecting from the available profiles in a 
drop down menu. 

10. Review the Dynamic Cross Sections. 

The template constraints define a template with two pavement layers: the topPVMT-OVL1 layer 

is 6” and the bottom PVMT-OVL2 layer is 1”. These two layers together make up the Backbone 

Thickness. 

For this case of raising the profile with no milling, the bottom of PVMT-OVL2 will be at or above 

existing ground between the range points. 

Recall that the vertical adjustment calculations compare template points to existing ground points 

only between the specified range points. In this case, the edges of the travel lanes were set as the 

range points. The turn lane was allowed to intrude into existing ground. 

 

Hint:      Hovering over the Dynamic Cross Section graphics reveals component 
outlines so that the boundaries of the wedge component can be reviewed. 

11. Generate a Profile Report. 

Hint:      Access the Profile context menu by selecting the profile and hovering over it. 

 Select the 3
rd

 icon.   

12. Generate a Components Quantities Summary Report for the corridor. 

 Why is there a value for the MILL component? 

____________________________________________________________________

____________________________________________________________________

____________________________________________________________________ 
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REFINE THE ADJUSTED VERTICAL ALIGNMENT 

While the profile coming out of the Overlay Vertical Adjustment tool is usable, it may need further 

refinement. 

This profile can’t be edited directly; however, the Profile by Best Fit tool can be used to create a new 

profile within the specified best fit parameters. After creating the best fit profile, the Convert to 

Profile Rule icon from the profile context menu allows editing of the best fit profile as long as there 

are not too many segments. By default, the limit to the number of elements is set at 250 for rules. 

Alternately, the designer may use the Vertical Geometry tools to draw new profile elements based on 

the adjusted profile. 

EXPORT ADJUSTED VERTICAL ALIGNMENT TO GPK 

Use General Geometry export tool same as for a vertical alignment created any other way. The profile 

must adhere to GPK naming restrictions. This includes no special characters and a 15 character limit. 

PRACTICE EXERCISES FOR VARIOUS OVERLAY AND MILLING SCENARIOS 

 Scenario 2: Raise profile by backbone thickness PLUS a non-zero Minimum Overlay value. 

These settings raise the profile by the total of the Backbone Thickness plus the Minimum Overlay 

Thickness. The total thickness of the uniform thickness pavement layers, PVMT-OVL1 and PVMT-

OVL2, is equal to the Backbone Thickness where applicable. 

From the previous exercise, the pavement layer thicknesses are set with Parametric Constraints so that 

the current values can be checked for compatibility with the Overlay Vertical Adjustment settings 

without having to get into the template library. 

The bottom of the pavement layers at least 1” (the Minimum Overlay Thickness value) above existing 

ground everywhere within the defined range. 
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 Scenario 3: Lower the profile from Scenario 2 by milling up to 2”. Mill only where needed. 

These settings adjust the profile such that at the critical point, there is a maximum of 2” of milling with 

4” of material filled back in = the equivalent of a 2” raise at the critical point.  

The desired layers are:  

3” of backbone material (OVL-LAYER1_THK) 

1” of the minimum overlay material in the wedge layer (MIN_OVERLAY_THK) 

Therefore, the MIN_OVERLAY_THK Parametric Constraint also needs to be added to cause the 

template to include the minimum the specified overlay thickness in the PVMT-WDGE layer. 

Milling of up to 2” occurs where needed to maintain the 1” minimum overlay thickness. 
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 Scenario 4: Change milling from only where needed to full width. 

This is a change to how the cross sections draw, the profile adjustment is the same as for Scenario 3 

because the adjustment is based on the same maximum milling value. 

To derive quantities and elevations for constant depth milling across the section, the 

CONST_MILL_THK Parametric Constraint is added using the same value that is used for the 

Maximum Milling input to the Overlay Vertical Adjustment.  This causes the milling component in the 

template to trace below existing ground at an offset equal to the CONST_MILL_THK value and the 

PVMT-WDG layer to follow it.. 

WORKING WITH A VARIABLE BACKBONE DEPTH 

There is a special parametric constraint available to accommodate adjusting the profile when the 

pavement (backbone) depth varies within a corridor. The overlay templates include a point called 

VERTADJ_BACKBONE which provides a Parametric Constraint, also called 

VERTADJ_BACKBONE. This parametric constraint is only used within the Overlay Vertical 

Adjustment Settings; it does not control anything about how the template draws the cross section. So 

the corresponding pavement layer(s) would also have to be set. 

To use the VERTADJ_BACKBONE parametric constraint, follow these steps: 

1. Open the Corridor Objects dialog. 

2. Select the Parametric Constraint leaf. 

3. Add a new constraints for VERTADJ_BACKBONE: 

a. the initial constant backbone depth with start and stop stations 

example shows 0.25initial backbone thickness – STA 267+00 to279+00 

b. the taper from initial backbone depth at the start station  to the second backbone 

depth at the stop station 

example tapers from 0.25 to 0.33 – STA 279+00 to 279+05 

c. the second constant backbone depth with start and stop stations 

example shows 0.33final backbone thickness – STA 279+05 to 290+00 

 

4. Make similar changes to the overlay OVL-LAYER1_THK variable, so that the cross section 

depths match the profile adjustment depths. (Generally, the combined thickness of LAYER1 

and LAYER2 will equal the backbone thickness. Recall that the LAYER1 and LAYER2 

values should be negative, while the backbone value is positive). 
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5. Open the Overlay Vertical Adjustment dialog. 

6. Select VERTADJ_BACKBONE for the Backbone Parametric Label. 

7. Move cursor into the view window and accept the dialog values by moving through the 

floating prompts. 

Note: This example uses only the VERTADJ_BACKBONE parametric constraint  to 
define a variable backbone entry to illustrate the effect. It is likely that the milling 
and/or overlay depths would vary if the backbone varies. The 
CONST_MILL_THK and MIN_OVERLAY_THK parametric constraints can be 
used to vary the milling and minimum ovleray depths. Unlike the 
VERTADJ_BACKBONE, these other Parametric Constraints are tied to the 
Milling and Wedge template components, so they affect both the Overlay 
Vertical Adjustment and how the template draws. 

Here is a close-up of the profile view showing that the profile now bumps up at this location. 

The red line (top line) shows the results of the new profile adjustment. The blue line (lower 

line) shows the original profile which had been adjusted for a constant backbone thickness.  
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INTRODUCTION 

Preliminary quantities are readily attainable as soon as the corridor is created and a template is 

assigned. The reporting feature of the model utilizes custom reports that can be used to quickly analyze 

alternatives during for corridor review and preliminary quantities only.  

Currently all earthwork for plans production will be derived from processing the model out to 

GEOPAK cross section cells and then running input files as it always has been done. 

PRELIMINARY QUANTITIES 

The Corridor Modeling > Component Quantities icon opens the Component Quantities window 

which provides total Surface Area and Volume quantities for the various materials for the entire 

corridor. This report used triangulated surface-to-surface volumes as opposed to the average-end-area 

method for computation. The Feature Definition entry for a template component (PAVE, SHLD, 

TOPSOIL etc.,) assigns a material to the component and defines whether a Surface Area or a Volume 

is calculated for that component.  The user can insert a Unit Cost value into the Component Quantities 

table to generate a preliminary cost estimate. 

Within the Component Quantities window, the Report button opens the Corridor Model 

Component Quantities report in the Bentley Report Browser. This report lists station to station end 

area values as well as corridor totals. This report can be saved into various file formats for use outside 

of GEOPAK. 

MnDOT has additional custom reports besides the standard reports delivered with the product. Most of 

these reports are formatted to be saved out to Excel.  

Note: The Report Browser contains many reports; each one is unique to a specific tool 
that generates the proper XML file format. For Example – The Template Drop 
report will not return results when the Component Quantities tool is selected. 

 Review Preliminary Quantities 

1. Open d340814_cm.dgn. 

2. Select the Corridor Modeling > Component Quantities icon. 

 

3. Graphically locate the corridor. 

From the Component Quantities window 

Which materials have Surface Area quantities? _______________________________________ 

Which materials have Volume Quantities? ___________________________________________ 

4. Add some unit costs to the reports 
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5. In the Component Quantities window, select the Report button. 

6. Review the report contents. 

7. In the Report Browser, click Tools > Format options. 

8. Review the settings and change the Cubic Units precision. Notice how the report updates. 

9. Select the Corridor Model Component Quantities Summary. 

10. Close the Report Browser. 

11. Remain here for the next exercise. 

 

CROSS SECTIONS FOR EARTHWORK CALCULATIONS 

The Create Cross Section icon in the Corridor Modeling task menu is used to generate traditional 

GEOPAK cross sections to be used for earthwork calculations and plan sheets. The cross sections will 

be drawn using symbology which is specified via the Feature Definitions assigned to the components 

in the templates. 

When the cross sections are drawn, they are drawn into a Drawing Model within the active design file. 

They will have to be annotated for stationing and labeling items such as ditch elevations and inslopes. 

This drawing model will have to be merged into the default model prior to running other GEOPAK 

processes like ancillary data or earthwork because GEOPAK cannot recognize multiple models within 

a design file when running traditional earthwork calculations or other legacy tools. 

 Create Cross section in the project_cm.dgn file 

1. From the Corridor Modeling task menu, select the Create Cross Sections tool. 

 

2. Graphically Locate the SOUTHST alignment. 

3. The Create Cross Section dialog opens. 

4. Click the Preferences button at the bottom of the window. 

5. Select the MnDOT-Stacked preferences file and then the Load button. 

6. Close the Preferences dialog. 

7. The Create Cross Section dialog updates to MnDOT Cross Section preferences. 

8. Display in View: select view 5 (an unused view) 

9. Select the Apply button. 

10. Close the Create Cross Section dialog. 

11. Note the following: 

 All views that were in use have been closed 

 View 5 opened with the cross sections drawn in the familiar stacked pattern.  

 Cross sections were placed in a new 2D Drawing Model created within this design file. 



Annotate Cross Sections 

 

Copyright © 2015 Minnesota Dept. of Transportation  Annotate Cross Sections 

4/16/2015  7-3 

 

 

 

ANNOTATE CROSS SECTIONS 

At this time there is limited annotation that will be done with the corridor modeling tools. Only the 

topsoil bottom feature is configured to be annotated. At MnDOT, the standards only allow the 

annotating of bottom of topsoil points with the Annotate Cross Sections tool. These allow you to get 

the inslope values and ditch elevations the same way they are displayed in our criteria. 

This is because limitations in the cell placement. The majority of the annotation will be done by 

running legacy after the fact criteria or ancillary features tools. 

 Review and Annotate Cross Sections 

1. Open the traditional GEOPAK Cross Section Navigator: 

GEOPAK > ROAD > Cross Sections > Navigator 

Use the arrows or drop down station selector to step through the cross sections. 
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2. From the Corridor Modeling task menu, select the Annotate Cross Sections tool. 

 

3. Verify the Cross Section Model and Surface is set to SOUTHST. 

 

4. Click the Preferences button. 

5. Load the Preference: 1-Slope. 

6. Click the Apply button. 

7. Load the Preference: 2-Ditch-Elev 

8. Expand the Features > Annotate. 

9. Select the crossing features as follows. 

Note: On the left side you will select the outside of the ditch (L-DTCH-BTM_BO), 
whereas on the right you will select the inside of the ditch (R_DTCH-BTM_BI). 
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MERGE SECTIONS INTO A SEPARATE DESIGN FILE 

You must copy in the sections run from the model into a separate file into the default model. This is 

done so legacy tools like, criteria, 3pc, ancillary features or other can be performed on them. 

 Merge Earthwork Cross Sections into Separate Cross Sections Design File 

1. Create new design file named d340814_xs1.dgn from the E2D seed file. 

2. Open the file and verify the design file settings. 

3. Attach the SOUTHST Drawing Model from the d340814_cm.dgn design file. 

4. In the Level display, verify that all levels are turned ON for the reference. 

5. Right-Click on the attached file in the Reference dialog. 

6. Select Merge Into Master from the pop-up menu. 

7. Left Click anywhere in the view window. 

8. Select OK to the message about the references selected for merging. 

9. Notice that the Reference file disappears from the References list. 

After merging the reference into the xs file. The SOUTHST drawing model in the corridor file should 

be deleted. 
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INTRODUCTION 

Pond design will use a combination of the civil tools to create the 3D and terrain. Different methods, 

procedures, and analysis tools will be utilized as required by the design constraints of the existing 

topography, site limitations, and pond characteristics. 

The method shown in the chapter uses tools that have not been introduced, such as horizontal 

geometry, linear templates and terrain model creation. The methods only show the user the basic 

concepts to get started. After creation of the terrain model, it will be exported as a tin file for legacy 

tool usage.  

FILE SETUP 

A pond can be created in its own file or the same file as an adjoining corridor. Similar to a corridor, 

any components of the pond should be contained in this file with limited references to external data. 

The exception to this is any existing ground terrain file or target corridor.  

The dgn file for this chapter already is been created from a new seed file with the cp1 and terrain 

model attached. See Chapter 1, Terrain Model for information on importing existing ground to a 

terrain model. 

CREATE USING CIVIL GEOMETRY 

Horizontal civil geometry tools will be used to create the bottom of pond geometry in the 2d file. 

Simple lines and arcs will be used for the basic shape and then made complex into an alignment.  

Civil Geometry elements retain the associations with other elements (rules) that are used to create or 

modify the element.  By thoughtfully selecting the drawing tool, drawing order, snap type, and snap 

location, element relationships will be properly set, such that when an element is updated and the 

associated elements also update, the original design intent is retained.  
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 Create Pond Bottom Geometry 

1. Open d340814_svz.dgn. 

2. From the Civil Tools >Horizontal Geometry Tasks, turn on the Feature Toggle Bar Tool. 

 

3. Set the Feature defenition to Linear> Geometry> POND and verify the Use Active Feature is 

depressed. 

 

4. From the Civil Tools >Horizontal Geometry Tasks, click the Line Between Points Tool.  

5. The Feature defenition should be greyed out and set to use active feature from the Feature 

Toggle Bar if the Use Active Feature is depressed.  

 

6. Draw lines to delineate the bottom of the pond geometry in the NW corner of the intersection. 

When placing the lines, draw them in a clockwise fashion so the geometry is heading in a 

similar direction. 
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7. From the Civil Tools >Horizontal Geometry Tasks, click the Simple Arc Tool.  

8. Set the following settings. 

 

9. Follow the prompts. Select the first componet and then the second to create a fillet in each 

corner, trimming both elements. As you did with the lines, draw them in a clockwise fashion 

so the geometry is heading in a similar direction. 

 

10. Continue until each corner has a radius. The bottom should look similar to below. 
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11. From the Civil Tools >Horizontal Geometry Tasks, click the Complex by Elements Tool. 

 

12. Change the name of the Feature to SSTPOND in the tool settings. 

13. Hover over the first element being aware of the direction arrow is pointing clockwise. The 

direction arrow determines the direction of the alignment.  Data point to select it. 

14. The entire boundary should highlight. Data point to Create. 

MODIFY LINEAR GEOMETRY 

Civil Geometry elements have Element Handlers, or Element Manipulators, associated with them. 

These are annotations which can also be selected and used to edit the element. For example, a line will 

have Element Handlers at the start and end which allow graphic repositioning of the start and end 

points, as well as annotation showing line length and direction which can be selected for key-in 

editing. The Element Handlers are hidden until the element is selected. 
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 Modify Pond radii 

1. Select the complex element. 

2. Hover over the round manipulator points to get tips on what action the grip performs. 

3. Use the element manipulators to change the radii or modify the lines. 

4. Notice how the Geometry updates.  

TERRAIN - ACTIVE TERRAIN / CONTOURS 

In order for corridors or linear templates to target a terrain, it must be set as active in the file. 

Otherwise the end conditions will not solve. 

In order to get an idea of the existing ground terrain, turn on the view of the contours. When 

referenced, the terrain inherits its display from how it is set up in the original file. This can be 

overridden by selecting the terrain and changing the Override and then modifying the Calculated 

Features display. 

Note: At this time, text displayed from a calculated terrain can NOT be printed. Either 
legacy tools would have to be used or contours manually labeled using the 
Terrain Tools. 

   

 Set Active Terrain - Turn on Contour Display 

1. Select the Existing ground boundary element. 

2. Using the context sensitive tools, Set as Active Terrain. 

3. Using either the context sensitive tools or the element information, override the terrain display 

and enable the contours. 
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4. In the Element Information dialog, expand the plus next to the Terrain model and calculated 

features. Highlight the Contours and modify the interval of the view display to 0.5 Minor and 

5 Major. 

  

 

5.  Return the settings back to Major Interval 5 and Minor Interval 1. 

ASSIGN VERTICAL GEOMETRY - CONSTANT ELEVATION PROFILE 

Once the alignment is constructed, a vertical profile must be created to assign the z value. With this 

information, the Default-3D model is created along with the 3d geometry for the complex element.  

 

 

 Apply Constant Elevation Profile to Pond Bottom 

1. From the Civil Tools >Vertical Geometry Tasks, click the Profile by Constant Elevation Tool. 

 

2. Change the elevation and name settings as follows. 

 

3. Locate the complex element created for the pond bottom. 



Linear Template 

 

Copyright © 2015 Minnesota Dept. of Transportation  Linear Template 

4/16/2015  8-7 

4. Accept. 

5. Open View 2 and set the Model to the Default-3D. Arrange the views if desired. 

 

6. Using the MicroStation view tools, rotate the View to Isometric. 

7. Verify that the 3D element for the pond bottom was created.  

8.  Zoom to the pond location. 

 

LINEAR TEMPLATE 

Linear Templates are useful in creation of site type objects in a design, such as a pond, parking lot or 

intersections..  

They can use the same templates as a corridor and should be stored in project library like the remainder 

of your project. Linear templates contain a single template drop and have fewer features than a full 

corridor.  

When comparing Linear Template objects to Corridor objects one can see that Linear templates are a 

scaled down version of a corridor. Many of the corridor tools still pertain to linear templates. 
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When placing a linear template you have the option to reflect the template. For this reason you may or 

may not designate a Left or Right template because of the option to reflect. What you do not want to 

do is have a left template on the right side or vice versa because it is confusing. 

 

LINEAR TEMPLATE OBJECTS: 

 

CORRIDOR OBJECTS: 

 

 Apply Linear Template to Pond Bottom 

1. Make View 1 your active view in MicroStation. 

2. Turn off the contours on the Existing Ground Terrain to get a better view of the elements. 

3. From the Civil Tools > 3D Geometry Tasks, click the Apply Linear Template Tool.  

4. Select the bottom of pond geometry. 

5. Follow the prompts using the settings as below: 

 Lock to the start and end so alignment modifications are accounted for. 

 Make sure the geometry is drawn to the outside and accept. 
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6. The pond geometry is drawn and ties to ground. 

Warning: If you did not set the Terrain to active previously the elements will not tie. 
A process will have to be done in order to get the terrain to tie. At this time the 
“Corridor Process” does not work with linear templates. A modification to the 
template would have to occur to trigger an update. 

MODIFY LINEAR TEMPLATE 

The pond bottom was created with the civil geometry and rules were assigned. Modification to this 

geometry will update associated geometry. Other potential modifications are to change the linear 

template geometry or use the corridor objects tools to make modification to the applied linear template. 

1. Select the template drop, click the Edit Template tool. 

2. Change the berm width to 12’ and modify the inslopes to be 1:3 (33%). 

3. Select the alignment and modify so that the limits of the pond fit the roadway geometry. 

CREATE TERRAIN MODEL FROM ALTERNATE SURFACE 

In order to obtain volumes for the pond a terrain must be generated from the graphics. Since we have 

linear template the component quantities could be used, but then you would need to compute the 

volume for the center of the pond separately. Instead we will create a terrain for the entire pond to get 

the volume in one operation. 

There are multiple methods that could be used to create the terrain. One method is to use the graphics 

added as break lines. A terrain model is a 3D element, but since the 2D graphical features from the 

template are linked to the 3D they can be used.  

Note: The method used in this lab creates a terrain for the finished surface. 

 Create Terrain Model 

1. With View 1 active, turn off the display of the self-referenced 3D-Default model. 
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2. From the Civil Tools > Terrain Model Tasks, select the Create from elements tool. 

 

3. With the following settings, select the pond graphics and create the terrain, be sure to include 

all the elements: 

 

4. The terrain is created in the Default-3D model. 

ANALYZE TERRAIN VOLUMES 

Once a terrain is created the volume can be analyzed with the terrain tools. This is a simple tool that 

reports the cut and fills either to a plane or an alternate terrain. An adjustment factor can be added if 

desired. 



Export Terrain to GEOPAK Tin 

 

Copyright © 2015 Minnesota Dept. of Transportation  Export Terrain to GEOPAK Tin 

4/16/2015  8-11 

 

 

 

 Analyze Terrain Volumes    

1. Select the Analyze Volume from the Terrain Model Task menu. 

2. Choose the Method Terrain Model to Terrain Model Volume. 

3. Choose the existing ground (d340814_exist) as the “From” terrain. 

4. Choose the pond (SST-Pond) as the “To” terrain. 

5. Use a cut and fill of 1.0 and no boundary. 

6. The result will display.  

Note: If you select the wrong “From” terrain the cut and fill volume will be flipped.   

EXPORT TERRAIN TO GEOPAK TIN 

In order to use legacy tools, the terrain must be exported to a tin file. This is possible using the Export 

to file tool in the Terrain Model task. 
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 Export Terrain to TIN 

1. Choose the Export to File tool. 

2. Set the terrain and the format. 

 

3. Save the tin to your student working folder in PW. 
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INTRODUCTION 

A fully built template will likely not be available that suits your project’s needs. Therefore it is 

necessary to assemble a Left and Right Side that meet your specific situation.  

Depending upon the nature of the roadway, it may be necessary to create a custom template. Custom 

templates will be created in the Project.itl template library within the ProjectTemplates folder.  There 

are too many permutations to build out every combination. Therefore, MnDOT has provided 

components and half templates in the standard template library to make creating custom templates easy 

by piecing together the necessary parts of the typical section. 

It is recommended to use the simplest template possible to meet the project requirements. If your 

roadway does not have turn lanes, assemble a template that does not have turn components. 

Hint:      Most of the available options are accessed with the right-click menu. It 
dynamically changes depending on the cursor position. For instance, when 
hovering on a point and right click you get a certain set of tools versus when 
you hover on a component or in space. 

Subgrade components can be merged together. After merging components, clean up names and parent 

child relationships in the components. This makes it easier to modify and report on. 

TEMPLATE OPTIONS 

The template options can be found in the template organizer by clicking Tools > Options in the Create 

Template dialog. These settings control options when templates are created or modified. 

 

Apply Affixes -The Affixes toggle determines whether or not automated prefix/suffixes are added 

when creating templates.  

Step Options -The step options control a grid snap in the template dialog. This helps to place 

components at a desired position in the template creation process. It is especially useful to help 

position the alignment of the template at 0,0. 
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Note: In general, if template components are added from a _Left or _Right directory, 
do not have the Affixes toggled ON. These components already have the 
standard affixes applied. 

DYNAMIC SETTINGS 

The Dynamic Settings dialog is very similar to the Template Options. It is very useful when creating 

template to have this open to review the Affix Setting and verify locations when adding points. It is 

suggested to always have your dynamic settings on when doing any modification. 

 

Note: Typical for CR10 provided at the end of this chapter. 

 Add Folders and Templates to the Project Library 

1. Open d340814_cm2.dgn file holding the CR10 alignment, profile and plan graphics 

information. 

2. Open the template library using the Create Template icon. 

3. Confirm that the template library that opened is the d340814.it. 

4. Highlight the root folder. Right click and select New > Folder. 

5. Rename the folder to CR10. 

6. Highlight the CR10 folder. Right click and select New > Template. 

7. Rename the template CR10-Rural. 

8. Examine the typical section for the rural part of CR10.  

(The typical section for CR10 is rural with paved shoulder on the left, and rural with 

composite shoulder on the right) 

How does the typical section differ from the Rural – 2 Lane – GradeSub template available in 

the MnDOT template library? ____________________________________ 

9. Using the Template Library Organizer, copy the following templates from the MnDOT 

Standard Template Library into the GradingTemplates folder of the project.itl.  

 GradingTemplates/_Left  – GgrdSgrd/L – Rural – LaneShldPI – GgrdSgrd 

 GradingTemplates/_Right  – GgrdSgrd /R – Rural – LaneShldpShldAPI (2)– 

GgrdSgrd 
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10. While in the Template Library Organizer, open the project.itl EndConditions folder and 

confirm that the Left and Right Ditch/Fill components are there. If not, copy them from the 

MnDOT Standard template library. 

11. Click the OK button and allow the changes to be saved to the project.itl. 

12. Remain here for the next exercise 

 

Once the template library is set up with organizational folders and the necessary templates from the 

standard template library, a new template can be put together. 

 

 Create Rural Template 

1. In the Create Template  interface,  review the two grading templates just added. Note that they 

are already left and right side specific, both in their orientation and the point names already 

include a L_ or R_ prefix. 

2. Open the newly created CR10-Rural template. 

3. Open the Dynamic Settings dialog using the rightmost icon at the bottom of the template 

viewing area. Confirm that the Step values are 0.2, and Apply Affixes is unchecked. 

 

4. Make sure the CR10-Rural is the active template. 

5. Single Click on the L – Rural – LaneShldpPI – GradeSub template so that it appears only in 

the Preview window. 

6. In the Preview Window template, left click and hold on the green point (highlighted by the 

blue box) . 

7. While still holding the left mouse button down, move the cursor to near the origin (pink box) 

in the Current Template window.  

8. When the template appears to snap to the origin, release the template. 

Hint:      Zoom in on the origin to make the snapping more obvious. 

Hint:      Create Template > Edit > Undo is available if needed. 
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9. Use the Fit View icon for the Create Template window to bring the complete template into 

view. 

10. Single click on the R – Rural – LaneShldpShldAPI(2)– GradeSub template so that it appears 

in the Preview Window. 

11. Using the green centerline point, drag and drop this template at the origin, too. Fit View. 

Hint:      The point indicator turns white when points are exactly aligned. 

 

12. Finally, add the Left and Right Ditch/Fill End conditions. The end conditions will be 

connected to the left and right edges of the pieces already put into the template. 

13. Fit View 
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14. Enter a description in the Description field at the top of the window. 

15. Hit the <Tab> key on the keyboard to preserve the description. 

16. Hover over various points, lines and components and Right click. This reveals a multitude of 

options available. 

17. Close the template library and save changes. 

 

 Merge Base and Subgrade Components 

1. Right-Click on the Subgrade and select Merge Components. 
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2. Do the same for the BASE components. 

3. Click Activate Template. 

4. In the components folder, remove the prefix L_ or R_ from the SGRD and BASE-GGRD 

components. 

5. When complete they should appear as follows. 

 

6. Save and exit. 
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INTRODUCTION 

At this point the basics of the workflow have been presented for simple projects which allow for the 

MnDOT Standard Templates to be used as is. Each project will have special situations which may 

require additional techniques.  

The recommended Corridor Modeling workflow for multi-lane configurations is to build a corridor for 

each alignment and to target points within the second corridor to match a corresponding point in the 

first. The MnDOT template library support multi-lane configurations in rural and urban conditions 

with the use of point controls. 

DIVIDED HIGHWAY CORRIDOR 

The recommended Corridor Modeling workflow for multi-lane configurations is to build a corridor for 

each alignment and to target points within the second corridor to match a corresponding point in the 

first.  

The standard MnDOT template library contains default templates that represent each side of rural or 

urban divided highways. The first side stops at a point which the second side used as a control point to 

determine the placement of the connecting elements. The first corridor which is run will determine the 

stationing at which cross section may be developed. Traditionally, this will be the eastbound or 

northbound alignment. 

REVIEW - 23EB, 23WB – MULTI CORRIDOR 

The first exercises create and connect adjacent corridors using a depressed median. 

 Create 23EB Rural Corridor Model – Connect to Adjacent Corridor 

1. Open the Project_cm1.dgn design file containing the highway 23 EB and WB alignments, 

profiles and plan graphics. 

2. In the template library: 

3. Create a folder for the alignment 

4. Create copy of the MnDOT rural 2-lane template into that folder. 

5. Rename the template to a project specific name. 

6. Delete the left side end conditions – keeping the PI component 

7. Edit the template to match typical values found at the end of the chapter. 

8. Note the name of the left-most top surface point:  L_PI_TO 

9. Create a corridor using the MnDOT rural 2-lane template 

10. Limit the corridor to the rural section between SOUTHST and CR10 

11. Add Horizontal Plan Graphics Features as Corridor references 

12. Add parametric constraints and point controls as needed 

13. Add Superelevation (Optional - Use Default Values for 55mph) 
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 Create 23WB Rural Corridor Model – Connect to Adjacent Corridor 

1. Create the 23WB corridor using steps similar to those used to create the EB corridor. 

2. For template management, create a 23WB template folder, and  put a copy of the MnDOT 

rural 2-lane template into that folder. 

3. Delete the right side end conditions and replace them with the depressed median Component. 

4. When the WB corridor is created, define a point control which controls the PI-SEARCH-TO 

point to target the EB Corridor Feature L_PI_TO. This provides the connection between the 

corridors.  

 

5. Review the corridor. 

6. If the cross sections do not automatically appear in the Dynamic Cross Sections window, then 

open the dynamic cross sections for this corridor, but select the same view that is already 

showing the EB cross section view. 

 

At the north end of the project, there are several driveways on the east side of EB23. At a driveway, 

the model needs to be truncated so that the ditch or tieslope no longer draws. This can be done by 

putting a new template drop at that location using a template that doesn’t have an end condition, it can 

be done using an End Condition Exception, or it can be done using special templates called civil cells 

which are mini-models which would clip out the model as created with the template containing the end 

condition and replace it with a model based on the civil cell information. 

The MnDOT workflow does not yet include Civil Cells, so the End Condition Exception is 

introduced here because it is somewhat simpler to manage than multiple template drops.  
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 Create 23EB Urban Corridor Model – End Condition Exceptions 

Use Backbone Only (Right) and zero out the width of the unneeded  components. 

Maybe shrink toe curb height down and zero out berm, walk etc. 
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OPTIMIZE CORRIDOR PROCESSING 

When creating the corridor, and ultimately the 3D model, there are a few recommended practices 

which will minimize processing time and make the design work more efficient.  

During the design process when details are changing or alternatives are being tested, it may be 

desirable to minimize the processing time by using a design stage or template interval that limits 

critical stations and decreased the template frequency so that results can be achieved and reviewed 

quicker. 

When multiple corridors are in the same file and a particular corridor is considered complete disable 

the processing of the corridor so the graphics do not regenerate. 

CORRIDOR LENGTH 

There is not a software limit to the corridor length, but the complexity of the project may dictate a 

practical corridor length. 

MnDOT uses a solid working area of 1 mile in its default seed file, therefore the maximum length 

between template drops in a corridor should be 1 miles. This was based on a recommendation from 

Bentley. Your own experience will likely be your guide in deciding appropriate corridor lengths for 

your projects. 

Note that the geometry does not need to be broken up into smaller segments, only the corridors. 

END CONDITION EXCEPTIONS VS. CLIPPING 

End condition exceptions and clipping references are both ways to force your corridor to ignore a 

template drop and do something else, usually in order to connect with something outside the active 

corridor. Note that in terms of processing time, the end condition exception requires less processing 

than clipping to a reference surface. 

PROCESSING CLIPPING REFERENCES 

Because clipping to a reference takes a lot of processing time, there is a “switch” which will turn off 

immediate processing of clipping references. With the automatic clipping update disabled, the clipping 

references can be added or edited all at once without processing, then the clipping reference processing 

can be enabled to process them all at once. 

REFERENCES 

Use as few external references as possible. This helps eliminate mistakes and unnecessary updating of 

files. 

DESIGN STAGES 

Use design stages to limit the frequency of template drops, critical stations and curve densification. 



Project Design File 
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DYNAMIC VIEWS OF PROFILES AND CROSS SECTIONS 

Limit the interaction jumping between the dynamic views. Do not leave dynamic views open unless 

needed.  These temporary views can be slow to switch between and slow to update when making 

changes. 

CORRIDOR LENGTH 

There is not a software limit to the corridor length, but the complexity of the project may dictate a 

practical corridor length. A suggested maximum corridor length is somewhere between 1 and 3 miles. 

Your own experience will likely be your guide in deciding appropriate corridor lengths for your 

projects. 

Note that the geometry does not need to be broken up into smaller segments, only the corridors. 

END CONDITION EXCEPTIONS VS. CLIPPING 

End condition exceptions and clipping references are both ways to force your corridor to ignore a 

template drop and do something else, usually in order to connect with something outside the active 

corridor. Note that in terms of processing time, the end condition exception requires less processing 

than clipping to a reference surface. 

CLIPPING REFERENCES 

Because clipping to a reference takes a lot of processing time, there is a “switch” which will turn off 

immediate processing of clipping references. With the automatic clipping update disabled, the clipping 

references can be added or edited all at once without processing, then the clipping reference processing 

can be enabled to process them all at once. 

PROJECT DESIGN FILE 

It is suggested to create a master project file that references in the separate corridor files for a project to 

view the project in its entirety. 

Once corridors developed the default 3D Models from the individual design files (project_cm #.dgn 

files) will be attached to the overall project “container” file, project_cm0. 

 

 Create Overall Project Modeling Design File ( Example Only) 

1. In ProjectWise, navigate to the modeling seed file. 

...CADDStandards\MnDOTStandards\DOT_MICRO\seed\3Dseed.dgn 

2. Copy the seed file to your student directory. 

3. Rename the file using the following entries: 

name: project_cm0.dgn 

description: all project models 

file name: project_cm0.dgn 

4. Open the project_cm0.dgn design file. 

5. Attach the project_dtm.dgn file using the following settings: 

a. Model: Default 

b. Logical Name:  Terrain 

c. Nested Attachments:  No Nesting 
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6. Attach each the following files as references: project_cm1, _cm2, _cm3 and _cm4.dgn using 

the following settings: 

a. Model: Default-3D 

Hint:      If there is not a Default-3D choice, then the terrain model still needs to be set 
as the active terrain model in that alignment file 

 

b. Logical Names: 

FILE NAME LOGICAL NAME WHEN ATTACHING 

project_cm1.dgn TH23 

project_cm2.dgn CR10 

project_cm3.dgn South Street 

project_cm4.dgn DQFront 

c. Nested Attachments: No Nesting 

 

 

7. In the References window, verify that the Default-3D model has been attached (look at 

hierarchy view or entry in Model column). 



OTHER TOPICS – Not yet included 
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8. Exit the References dialog 

OTHER TOPICS – NOT YET INCLUDED 

SITE TOPICS 

Ponds 

Parking lots 

Intersections 

GENERATE REPORTS/DELIVERABLES 

Staking Reports 

Machine control files 
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